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Ketentuan 

Dokumen ini merupakan hasil kesepakatan dari pihak-pihak sebagai berikut: 

● Disasater Management Innovation (DMInnovation) 

● Humanitarian OpenStreetMap Team (HOT) 
 

Seluruh isi dan materi dalam dokumen ini kemungkinan masih dapat mengalami 

perubahan tanpa pemberitahuan publik. 

 

Lisensi 

 

Seluruh materi dan isi kandungan dalam modul ini adalah milik domain publik. 

Anda dapat menyalin, memodifikasi, menyebarluaskan, dan menampilkan 

modul ini, secara keseluruhan tanpa meminta izin. 

 

Keterangan lebih lanjut mengenai lisensi domain publik: 

http://wiki.creativecommons.org/Publicdomain/zero/1.0/LegalText_(Indonesian) 
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Tentang Kami 

 

Disaster Management Innovation (Dahulunya AIFDR) 

 

 

Disaster Management Innovation adalah investasi bantuan Pemerintah Australia 

yang terbaru melalui Geoscience Australia di Indonesia. DMInnovation dibangun 

untuk melanjutkan keberhasilan Australia-Indonesia Facility for Disaster 

Reduction (AIFDR) sebelumnya yang merupakan inisiatif bersama antara 

pemerintah Australia dan Indonesia. AIFDR diluncurkan oleh Pemerintah 

Australia dan Indonesia pada upacara khusus pada tanggal 15 Juli 2010 dan 

secara resmi ditutup pada bulan Agustus 2015. DMInnovation akan 

mempertahankan program bantuan teknis ilmiah yang akan digunakan dalam 

kegiatan kemitraan antara lembaga ilmu pengetahuan Indonesia dan Geoscience 

Australia. 
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Humanitarian OpenStreetMap Team (HOT) 

 

 

 

Peta gratis dan kolaboratif mempunyai keunikan yang berharga untuk pekerjaan 

kemanusiaan, terutama di tempat-tempat dimana peta dasar sangat jarang 

ditemukan, datanya sudah lama, atau seringkali berubah. Dibangun dalam dua 

tahun dari kolaborasi secara  informal, Tim Kemanusiaan OpenStreetMap 

merupakan sebuah inisiatif yang baru untuk mengaplikasikan prinsip dan 

aktifitas dari sumber terbuka dan berbagi data terbuka untuk menuju respon 

kemanusiaan dan pembangunan ekonomi. 

 

https://www.hotosm.org/ 

http://openstreetmap.id 
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Training Data 

Semua data pelatihan ini sudah disesuaikan untuk setiap modul materinya. 

Untuk dapat mengunduh data pelatihan ini, Anda dapat mengunduhnya 

pada link berikut ini: http://bit.ly/QGISforDM.   
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Modul 1: SIG untuk Penanggulangan Bencana 

 

Tujuan Pembelajaran: 

● Dapat mengetahui perbedaan antara data dan informasi 

● Dapat memahami pentingnya data 

● Dapat memahami konsep dasar SIG dan elemennya 

● Dapat memahami peran SIG dalam penanggulangan bencana 

● Dapat memahami kelebihan QGIS dan InaSAFE dalam penanggulangan bencana 

 

1.1 Perbedaan antara Data dan Informasi 

Data adalah kumpulan fakta yang masih mentah. Informasi adalah data yang sudah 

diolah, diorganisir dan disajikan sedemikian rupa sehingga data tersebut berguna dan 

mudah dipahami. Misalnya, ketika kita melakukan pemetaan lokasi beserta fakta tentang 

lokasi tersebut, berarti kita mengumpulkan data dan fakta. Untuk menjadikan data 

tersebut menjadi informasi yang bermakna, kita harus menyajikan data tersebut 

sedemikian rupa agar mudah dimengerti. 

Data OpenStreetMap dibuat seinformatif mungkin. Peta yang kita lihat di website 

OpenStreetMap sudah diproses dari data OpenStreetMap dan disajikan sebagai peta yang 

bagus, informatif dan bermakna. Dalam modul ini, kita akan belajar bagaimana 

melakukan analisis data spasial sehingga data spasial tersebut menjadi lebih berguna, 

informatif dan efektif. 

1.2 Pentingnya Data 

Data sangat berpengaruh pada hasil akhir analisis kita. Jika data yang digunakan memiliki 

kualitas yang buruk, maka hasil analisis juga akan buruk. Oleh karena itu, semakin detail 

dan akurat data yang kita gunakan, akan semakin baik pula hasil analisisnya. 
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Untuk memperoleh data, kita dapat mengumpulkannya sendiri atau mendapatkannya 

melalui badan atau institusi terkait. Misalnya, kita dapat memperoleh data ancaman atau 

data populasi dari organisasi atau badan yang memang bergerak di bidang terkait. Untuk 

data infrastruktur, sebaiknya diperoleh dengan pengumpulan data pada komunitas, 

dimana kita dapat menanfaatkan OpenStreetMap sebagai wadahnya. 

1.3 Terminologi SIG 

Sistem Informasi Geografis (SIG) adalah sebuah sistem yang didesain untuk 

memungkinkan kita untuk bekerja dengan data spasial. SIG memungkinkan kita untuk 

membuat, menyimpan, memanipulasi dan menganalisis data spasial. Cakupan SIG sangat 

luas dan dapat melibatkan hardware dan software yang kompleks di dalamnya. Namun 

bagi sebagian orang, sebuah software GIS sederhana sudah cukup untuk memenuhi 

kebutuhannya. 

SIG menyediakan banyak cara untuk menganalisis data. SIG memungkinkan kita untuk 

menjawab pertanyaan yang kompleks, seperti: 

● Dimana saja sekolah yang muridnya berjumlah lebih dari 100 orang? 

● Berapa banyak anak-anak yang tinggal di Kecamatan A? 

● Berapa banyak wanita yang tinggal dalam radius 500 meter dari Rumah Sakit B? 

● Jalan mana yang jaraknya paling pendek dari titik A ke Rumah Sakit B? 

1.4 Elemen-Elemen Penting di SIG 

Sebuah SIG terdiri dari beberapa elemen yang meliputi input data, manajemen data, 

manipulasi dan analisis data serta hasil (output). Input data merupakan proses 

memasukkan data ke dalam SIG. Setelah dimasukkan, data dikelola dan kemudian diolah 

serta dianalisis. Setelah dianalsis, hasilnya dapat ditampilkan dalam berbagai bentuk 

seperti peta ataupun laporan. Namun sebelum melakukan analisis, perlu diperhatikan 

jenis/tipe data yang digunakan beserta proyeksi yang digunakan. 

1.4.1 Tipe Data SIG 

Tipe data SIG dibagi menjadi dua yaitu data spasial dan dan data non spasial. Data spasial 

adalah data yang memiliki referensi ruang kebumian dimana berbagai data atribut 

terletak dalam berbagai unit spasial. Referensi ruang kebumian yang dimaksud adalah 
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berupa keterangan posisi absolut objek di atas permukaan bumi (lintang/bujur). Data 

spasial ada dua jenis yaitu data vektor (titik, garis dan poligon) dan data raster (grid atau 

piksel). Sedangkan data non spasial berupa data tabular (atribut) yang terintegrasi 

dengan data spasial. 

1.4.2 Sistem Proyeksi 

Sistem proyeksi adalah cara pemindahan permukaan bumi ke atas permukaan peta. 

Dengan menggunakan sistem proyeksi maka segala sesuatu yang di permukaan bumi 

yang berbentuk bulat (tiga dimensi) dapat dipindahkan ke bidang datar (dua dimensi). 

Berdasarkan bidang proyeksi, ada tiga jenis proyeksi yaitu proyeksi silindris, proyeksi 

kerucut dan  proyeksi planar. Proyeksi silindris menggunakan silinder sebagai bidang 

proyeksinya dan menyinggung bola bumi (untuk lebih jelas, lihat Gambar 1 bagian a). 

Proyeksi kerucut menggunakan kerucut sebagai bidang proyeksinya (untuk lebih jelas, 

lihat Gambar 1 bagian b). Proyeksi silindris lebih tepat digunakan pada lokasi yang dekat 

dari garis khatulistiwa. Proyeksi kerucut paling tepat digunakan untuk memetakan 

daerah lintang 45˚ atau lintang tengah. Sedangkan proyeksi planar menggunakan bidang 

datar sebagai proyeksinya dan menyinggung bola pada kutub, ekuator atau di sembarang 

tempat (untuk lebih jelas, lihat Gambar 1 bagian c). 

 

Gambar 1. Jenis Proyeksi Berdasarkan Bidang Proyeksi 

Sebelumnya sudah dijelaskan bahwa data spasial adalah data yang memiliki informasi 

posisi absolut di atas permukaan bumi yang berupa titik koordinat. Agar koordinat ini 
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konsisten, diperlukan standar dalam pendefinisian koordinat dari suatu objek dalam 

ruang. Inilah yang disebut Sistem Referensi Koordinat (Coordinate Reference System). 

Secara umum, SRK (CRS) dibagi menjadi dua kelompok yaitu Sistem Koordinat Geografis 

(Geographic Coordinate System) dan Sistem Koordinat Proyeksi (Projected Coordinate 

System). Sistem Koordinat Geografis menggunakan garis lintang dan bujur untuk 

menunjukkan lokasi suatu objek di permukaan bumi. WGS84 (World Geodetic System 

1984) adalah contoh sistem koordinat geografis yang sangat umum digunakan. WGS84 

adalah sistem yang saat ini digunakan oleh sistem satelit navigasi GPS. WGS84 

menggunakan satuan derajat (degrees). 

  

Gambar 2. Sistem Koordinat Geografis  

UTM (Universal Transverse Mercator) adalah contoh sistem koordinat proyeksi yang 

sangat umum digunakan. UTM membagi permukaan bumi menjadi 60 zona yang masing 

selebar 6 derajat pada garis bujur (longitude). UTM menggunakan satuan meter. Sistem 

koordinat UTM ini lebih tepat digunakan apabila kita ingin menghitung luas suatu 

wilayah dari sebuah data vektor, membuat raster dengan ukuran pixel yang ditentukan 

sebelumnya (misalnya 100x100m), dan membuat penyangga/buffer dari sebuah data 

vektor. 
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Gambar 3. Zona UTM Dunia dan Zona UTM di Indonesia 

1.5 SIG untuk Penanggulangan Bencana 

SIG memiliki peranan penting dalam penanggulangan bencana. Penanggulangan bencana 

bertujuan untuk mengelola dan mendukung kesiapsiagaan, mitigasi, pencegahan, respon 

dan rehabilitasi pemerintah dan komunitas dari kejadian bencana yang potensial seperti 

gempa atau tsunami. Tujuan dari penanggulangan bencana ini adalah untuk 

meminimalisir korban serta kerugian jika terjadi bencana. 

Sebelum merencanakan penanggulangan bencana, sebaiknya pertimbangkan skenario-

skenario potensial bencana nya. Seorang pengelola penanggulangan bencana akan 

bertanya: 

● Bencana seperti apa yang mungkin terjadi? 

● Bagaimana mencegah bencana tersebut? 

● Seberapa besar dampaknya? 

● Siapa yang bertugas untuk membantu? 



6 

 

● Bantuan apa saja yang diperlukan? 

● Apa yang harus kita lakukan ketika bencana sudah terjadi? 

● Dimana area prioritas nya? 

Dengan kata lain, penanggulangan bencana menjawab pertanyaan siapa melakukan 

apa, dimana dan kapan? 

Sebuah Sistem Informasi Geografis dapat membantu para perencana menjawab 

pertanyaan-pertanyaan tersebut, khususnya elemen spasial penting dari rencana 

kontinjensi. SIG dapat digunakan untuk memeragakan kejadian bencana sehingga 

bencana dapat diprediksi dengan lebih baik. 

SIG juga dapat digunakan untuk merencanakan rute evakuasi sebelum terjadi bencana. 

Saat bencana terjadi, SIG dapat juga memegang peran dalam fase tanggap darurat. SIG 

dapat digunakan untuk memetakan area terdampak dan lokasi-lokasi pengungsian 

sehingga para relawan dan bantuan dapat diarahkan langsung ke lokasi-lokasi yang 

paling membutuhkan. Setelah terjadi bencana, SIG dapat juga digunakan untuk 

merencanakan rehabilitasi dan rekonstruksi. Secara keseluruhan, SIG membantu dalam 

melakukan analisis dari sebuah bencana, kerusakan dan kerugian yang ditimbulkan dan 

peluang untuk mengurangi risiko. 

1.6 QGIS dan InaSAFE 

QGIS adalah sebuah software SIG yang gratis, mudah digunakan dan bersifat opensource. 

QGIS dapat dioperasikan pada komputer berbasis Windows, Mac OSX dan Linux. QGIS 

memiliki berbagai macam kemampuan melalui fungsi utama dan plugins. Anda dapat 

melakukan visualisasi data, mengelola data, mengedit data, menganalisis data dan 

membuat peta siap cetak. 

QGIS memiliki banyak kelebihan: 

● Gratis. Tidak perlu membayar sepeserpun. 

● Bebas. Jika Anda merasa sebuah fitur tidak ada di QGIS, Anda dapat menjadi 

sponsor untuk pengembangan fitur tersebut. Atau tambahkan fitur Anda sendiri 

apabila Anda familiar dengan pemrograman. 

● Terus-menerus berkembang dan diperbarui. Banyak orang terus menambahkan fitur-

fitur baru di QGIS. Hal ini yang menyebabkan, QGIS menjadi semakin lebih baik. 
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● Tersedia dokumentasi serta bantuan yang ekstensif. Jika Anda memiliki 

kendala, Anda selalu dapat membuka dokumentasi software atau bertanya 

pada pengguna QGIS lain atau bahkan pengembang QGIS. 

QGIS memiliki banyak plugins/perangkat tambahan sehingga memperluas fungsi 

utama dari QGIS itu sendiri. Salah satu plugins tersebut adalah InaSAFE, yang dapat 

digunakan untuk menganalisis sebuah bencana dan membuat sebuah daftar tindakan 

yang harus dilakukan ketika terjadi bencana. QGIS dan InaSAFE dapat juga membantu 

dalam penentuan lokasi pengungsian yang ideal, rute evakuasi, area yang mungkin 

terdampak dan lain-lain. 

InaSAFE menyajikan ringkasan dari potensi skenario-skenario bencana, dampak, serta 

peta yang dapat membantu pengambil keputusan saat terjadi bencana. Peta adalah 

sebuah sarana komunikasi yang efektif terutama ketika membicarakan dampak bencana, 

misalnya dengan menunjukkan area terdampak seperti area terdampak banjir dan 

bangunan terdampak banjir. 

 

Gambar 4. Plugin InaSAFE pada QGIS 
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Pada modul ini Anda telah mempelajari perbedaan antara data dan informasi. Kualitas 

data sangat mempengaruhi hasil akhir dari analisis yang dilakukan. Anda juga telah 

mempelajari apa itu SIG, elemen penting didalamnya serta peranan SIG dalam 

penanggulangan bencana. Software SIG yang sangat bermanfaat dalam kebencanaan 

adalah QGIS. QGIS memiliki plugin InaSAFE yang berguna untuk menganalisis sebuah 

bencana dan membuat sebuah daftar tindakan yang harus dilakukan ketika terjadi 

bencana. 
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Modul 2: Dasar-dasar QGIS 

Tujuan Pembelajaran 

● Men-download QGIS 

● Meng-install QGIS 

● Membuka proyek QGIS yang telah disimpan sebelumnya 

● Memahami panel layer 

● Mengakses tool dasar melalui toolbar 

● Membersihkan toolbar 

● Menampilkan peta melalui jendela peta 

Pada bab ini kita mulai menggunakan QGIS. Kita akan lihat bagaimana cara menginstal, 

memahami layout, tampilan antarmuka dan fungsi utama dari perangkat lunak ini. Pada 

akhir bab ini, Anda akan memulai jalan Anda untuk menjadi pengguna SIG yang 

kompeten! 

Perhatikan jika Anda telah menginstal QGIS, anda bisa langsung memulai pada bagian 

“Layout tampilan QGIS”.  

2.1 Mendapatkan QGIS 

1. Buka browser internet Anda dan ketikkan pada bagian atas jendela browser Anda 

dengan tulisan qgis.org. Kemudian tekan Enter. Situs resmi QGIS akan terlihat 

seperti ini: 
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2. Klik Download Now 

3. Jika Anda menggunakan Windows, temukan versi Latest release (richest on 

features) dan klik pada QGIS Standalone Installer Version 2.18 (32 bit atau 64 bit 

tergantung dari sistem operasi komputer anda). Nomor versi komputer Anda 

mungkin berbeda dengan apa yang ada pada webiste QGIS. 

 

4. Jika Anda tidak menggunakan Windows, pilih Sistem Operasi Anda dari menu 

yang tersedia. Ikuti intruksi instalasi. 

5. Ketika file selesai didownload, jalankan dan ikuti perintah untuk menginstal QGIS. 

2.2 Instalasi QGIS 

1. Buka folder dimana anda menyimpan file instalasi QGIS. 

 

2. Jalankan file instalasi tersebut. Jika Anda menginstal QGIS versi 2.x, akan terlihat 

seperti ini: 
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3. Klik Next. 

4. Klik I Agree untuk setuju dengan syarat dan ketentuan yang berlaku pada 

persetujuan lisensi. 

6. Pada jendela berikutnya, klik Install tanpa mencentang apapun yang ada di dalam 

kotak. QGIS akan memulai untuk menginstall. Ini mungkin akan membutuhkan 

beberapa waktu untuk selesai. 

7. Klik Finish untuk melengkapi instalasi. 

8. Sekarang buka folder QGIS 2.X di desktop anda dan pilih QGIS Desktop 2.x with 

Grass dari folder tersebut. Opsi lainnya Anda bisa langsung mencari QGIS 

Desktop 2.x with Grass dari Start Menu Anda. 
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2.3 Layout tampilan antarmuka pengguna QGIS 

Ketika Anda sudah berhasil membuka QGIS, tampilan QGIS akan terlihat seperti ini:  

 

Silahkan pilih “Project – Open”  atau klik gambar  yang ada di toolbar bagian kiri 

atas. Buka file proyek 2_Dasar_dasar_QGIS.qgs yang ada pada “QGIS Training 

Data/2_Dasar dasar QGIS”. Tampilan QGIS anda akan seperti dibawah ini: 
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Kanvas Peta/Bidang Peta 

Ini akan membuka jendela dimana peta yang kita buat ditampilkan. Proyek kita terdiri 

dari dua file yang berbeda, satu yang menggambarkan data administrasi kotamadya 

Jakarta, dan satu lagi menmenggambarkan jaringan jalan yang ada di daerah Jakarta 

Pusat. Anda dapat melihat kedua file ini akan digambar pada area yang sama di Map 

Canvas. 

Panel Layer 

Pada bagian kiri QGIS terdapat daftar layer. Daftar ini menampilkan layer-layer, atau file, 

yang dimasukkan ke dalam proyek QGIS. Pada proyek ini, kita memiliki dua layer, 

Jalan_OSM_Jakarta_Pusat_WGS84 dan Batas_Kotamadya_Jakarta_WGS84. 

Panel layer tidak hanya menunjukkan semua file yang kita buka, tetapi juga menjelaskan 

susunan urutan yang akan kita gambar pada map canvas. Sebuah layer yang terdapat di 

posisi paling bawah akan tergambar pertama kali dan beberapa layer yang terdapat 

diatasnya akan digambar pada posisi paling atas. 

 

Toolbars 

Pada bagian atas dari tampilan QGIS terdapat banyak sekali tool, yang tergabung dalam 

berbagai toolbar. Sebagai contoh, toolbar File memungkinkan Anda untuk menyimpan, 

membuka, mencetak dan memulai proyek baru. Kita telah menggunakan salah satu alat 

dari tool ini ketika kita membuka proyek ini. 

 

Dengan mengarahkan mouse Anda kepada icon yang tersedia, nama tool tersebut akan 

muncul untuk membantu Anda mengidentifikasi setiap tool. 

Jumlah tool (tombol) yang ada akan tampak sangat banyak pada awalnya, tapi Anda 

perlahan akan mengenalnya. Tools yang ada dikelompokkan sesuai dengan fungsi pada 

toolbars. Jika Anda melihat lebih dekat, Anda akan melihat 10 titik-titik vertikal pada 

bagian kiri dari setiap toolbar. Jika Anda meng-klik dan menahannya dengan 

menggunakan mouse Anda, Anda dapat menggerakkan toolbar ke tempat yang lebih 

sesuai atau memisahkannya sesuai dengan keinginan Anda. 
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Meskipun tidak terlihat pada toolbar, semua tool-tool Anda akan tetap bisa diakses 

melalui Menu. Sebagai contoh, jika Anda menghilangkan toolbar File (yang terdapat 

tombol Simpan), Anda masih dapat menyimpan peta Anda dengan pergi ke “Project ‣  

Save”.  

 

Status Bar 

Status bar akan menampilkan informasi mengenai peta Anda. Ini juga memperbolehkan 

Anda untuk mengatur skala peta dan melihat koordinat yang mouse Anda arahkan pada 

peta. 

 

Koordinat peta ini sama dengan tipe koordinat yang telah Anda pelajari apabila Anda 

telah familiar mengenai cara menggunakan GPS. Status bar ini akan menunjukkan posisi 

lintang dan bujur dari kursor mouse Anda. Hal ini mungkin akan terlihat membingungkan 

bagi Anda, namun seiring bertambahnya kemampuan SIG Anda,pasti Anda akan lebih 

memahaminya. 

 

2.4. Menambahkan layer vektor 

Sekarang kita akan menambahkan layer baru yang berisi tentang sebaran bangunan di 

proyek yang sedang kita buka. 

1. Klik pada tombol “Add vector layer”  pada toolbar sebelah kiri. 
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2. Sebuah jendela dialog akan muncul. Klik pada tombol “Browse” . 

 

3. Navigasikan ke tempat folder penyimpanan data latihan dan buka data 
Bangunan_OSM_Jakarta_Pusat.shp. 

 

4. Sekarang Anda akan melihat sebuah layer baru akan muncul pada kanvas peta 

anda. 

2.5 Tool-tool Dasar QGIS 

Kita telah melihat pada toolbar QGIS dan melihat tool untuk membuka proyek dan 

menambahkan layer baru. Di bawah ini akan ditampilkan beberapa daftar tool yang 

sering digunakan. Silahkan jika Anda ingin mengeksplorasi tools tersebut. Hal ini 

bertujuan untuk membuat kita merasa familiar dan terbiasa dengan QGIS. 

 

New  Memulai lembar kerja baru 

 
Open project Membuka proyek yang sudah disimpan 

sebelumnya 

 

Save Menyimpan proyek yang sedang 

dikerjakan/dibuka 

 

Save as.. Menyimpan proyek baru dengan nama yang 

ditentukan oleh pengguna 

 

Note: 

Format file yang sering digunakan dalam GIS adalah shapefiles dengan akhiran file .shp. Shapefiles juga 

sering digunakan untuk menyimpan sebuah geodata dan lebih sering digunakan dalam aplikasi GIS 

seperti QGIS atau ArcGIS. 
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Toggle Editing Mengaktifkan metode editing (penambahan data 

atau penghapusan data) suatu fitur pada layer 

yang dipilih dari Layer panel/daftar layer 

 

Menggerakkan Peta Menggeser peta ke lokasi yang kita inginkan 

 

Perbesar Perbesar peta 

 

Perkecil Perkecil peta 

 

Perbesar keseluruhan Perbesar agar semua layer tampak pada jendela 

peta 

 

Buka Tabel Attribut Membuka tabel atribut dari sebuah layer yang 

dipilih. 

 

Memilih satu fitur Memilih fitur dari layer yang dipilih. Fitur yang 

terpilih akan berwarna kuning. 

 

Membatalkan pilihan 

fitur  

Membatalkan pilihan fitur dari semua layer yang 

ada. 

 

2.6 Menavigasikan Peta 

Sebelum kita melihat atribut dari fitur secara individual, mari kita lihat bagaimana 

menggerakkan peta. Kontrol utama untuk menggerakkan, memperbesar atau 

memperkecil peta berada pada panel di bagian atas QGIS. 

 

Ketika Anda meng-klik salah satu tombol tersebut akan mengubah fungsi mouse Anda 

pada jendela peta. 

1. Pilih tombol pertama yang terlihat seperti gambar tangan. Sekarang klik kiri 

mouse Anda dan tahan kemudian geser pada jendela peta. Ini memungkinkan 
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Anda dapat menggerakkan peta ke arah yang Anda inginkan. 

2. Tombol yang berbentuk kaca pembesar dengan tanda tambah membuat Anda 

dapat memperbesar peta. Pilih tombol ini dan buatlah kotak di sekitar area yang 

ingin Anda perbesar dan lepaslah mouse Anda. 

3. Tombol yang berbentuk kaca pembesar dengan tanda minus membuat Anda dapat 

memperkecil peta. Pilih tombol ini dan klik pada peta. 

4. Tombol yang berbentuk kaca pembesar dengan tanda panah berwarna merah 

mengarahkan Anda menuju tampilan peta secara keseluruhan. Ketika Anda meng-

klik tombol ini, Anda dapat melihat semua data yang Anda masukkan pada map 

canvas. 

 

2.7 Mengatur Plugin 

QGIS mempunyai menu utama, dimana kita akan melanjutkan eksplorasi lebih jauh pada 

panduan ini, Selain itu, QGIS juga memungkinkan Anda untuk memasang plugin tambahan sehingga 

akan memudahkan Anda dalam bekerja. Dan lagi, plugin ini tidak berbayar. Untuk 

menggunakannya, Anda hanya butuh terhubung dengan internet dan menginstallnya. 

Pertama-tama harus mendownload pluginnya kemudian mengaktifkannya. Beberapa 

plugin telah terdownload dan dapat digunakan, Anda dapat melihatnya dengan pergi ke 

“Plugins ‣  Manage and Install Plugins”.  

 

Jendela ini menampilkan daftar plugin yang telah terdownload dan dapat diaktifkan. 

Untuk mengaktifkan sebuah plugin, centanglah kotak disampingnya pada menu ini. 

Untuk sekarang, mari kita biarkan dahulu plugin-plugin ini apa adanya. Kita akan 

mencoba mendownload dan mengaktifkan plugin baru di sesi berikutnya. 
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Terdapat lebih banyak lagi plugin, tetapi mereka harus didownload terlebih dahulu. 

Untuk mendownload sebuah plugin, pergilah ke tab Tidak terpasang. Tab ini akan 

menampilkan plugin yang tersedia di dalam repositori, dan Anda akan melihat daftar 

plugin yang dapat didownload. 

Perlu diingat bahwa plugin yang telah didownload dapat diaktifkan atau dinon-aktifkan 

dari tab Terinstall. Jika belum terdownload, mendownload sebuah plugin dari tab Tidak 

terpasang akan secara otomatis mengaktifkan plugin tersebut. 

Sekarang kita akan menginstal plugin InaSAFE. 

1. Pergi ke menu “Plugins > Manage and install plugins”.  

 

2. Arahkan ke kotak pencarian dan ketikkan “inasafe” 

 

3. Pilih InaSAFE dan klik “Install plugin”  dan tunggu hingga muncul 

pemberitahuan yang menunjukkan bahwa plugin sudah terinstal dengan sukses. 
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Sekarang Anda sudah mengetahui dasar QGIS mulai dari cara menginstal, memahami 

layout QGIS, mempelajari toolbar penting dan operasi dasar pada QGIS. Anda juga sudah 

belajar begaimana menginstal InaSAFE, sebuah plugin yang akan kita pelajari lebih lanjut. 
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Modul 3: Dasar Proyeksi Peta 

Tujuan Pembelajaran 

● Memahami Sistem Referensi Koordinat (Coordinate Reference Systems / CRS) 

● Mengidentifikasi Sistem Referensi Koordinat dari data vektor 

● Melakukan proyeksi ulang “on the fly” 

● Menyimpan data dengan Sistem Referensi Koordinat yang berbeda 

● Georeferensi citra dijital 

Kami telah membicarakan sedikit mengenai Sistem Referensi Koordinat sebelumnya, 

tetapi belum secara mendalam. Pada bab ini kita akan mempelajari lebih banyak 

mengenai Sistem Referensi Koordinat secara praktis dan bagaimana Sistem Referensi 

Koordinat mempengaruhi pekerjaan kita di QGIS. 

3.1 Sistem Referensi Koordinat 

Sistem Referensi Koordinat pada semua data dan juga pada peta itu sendiri pada 

umumnya berada pada Sistem Referensi Koordinat WGS84. WGS84 ini adalah Sistem 

Koordinat Geografis yang paling sering digunakan pada data spasial. Sistem referensi 

koordinat WGS84 menggunakan satuan derajat menit detik dan menggunakan akhiran 

seperti Lintang Utara (LU), Lintang Selatan (LS), Bujur Timur (BT), dan Bujur Barat (BB). 

Tetapi ada beberapa masalah pada sistem referensi WGS84 seperti yang akan kita lihat 

dibawah ini: 

1. Buka file “continents.shp” pada folder “QGIS Training Data/3_Dasar proyeksi 

peta”. 

2. Perbesar peta ke Indonesia menggunakan tool perbesar. 

 

3. Atur skala pada kotak skala yang ada pada bar di bagian bawah pada layar. Ketika 

peta sudah menunjukkan Indonesia, atur nilai skala menjadi 1:20000000 (satu 

banding dua puluh juta).  

 

4. Silahkan geser sedikit petanya sambal tetap memperhatikan kotak skala. 
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Apakah anda sadar bahwa terjadi perubahan skala? Hal ini terjadi karena anda menjauh 

dari satu titik yang anda perbesar pada 1:20000000 yang berada di tengah-tengah layar 

anda. Di sekeliling titik itu, skalanya berbeda. 

Untuk mengerti mengapa hal itu bisa terjadi, pikirkan tentang bola dunia. Bola dunia 

memiliki garis yang membentang dari utara ke selatan. Garis bujur ini berjauhan di 

khatulistiwa, tetapi mereka bertemu pada satu kutub. Dalam Sistem Koordinat Geografis, 

anda sedang mengerjakan suatu bidang peta, tetapi layar anda rata. Jika anda mencoba 

untuk mewakili bidang bumi yang permukaannya rata, hal ini menjadi terdistorsi, seolah-

olah anda mengambil kulit jeruk dan mencoba meratakannya. Hal ini menjelaskan bahwa 

pada peta, garis bujur tetap terpisah satu sama lain, bahkan di kutub (dimana mereka 

seharusnya bertemu). Hal ini berarti saat anda menggeser jauh dari garis khatulistiwa di 

peta anda, skala pada objek yang anda lihat akan semakin besar dan besar. Hal ini artinya 

untuk kita secara praktis, tidak ada skala yang konstan pada peta kita! 

Untuk mengatasi masalah ini, kita akan menggunakan Sistem Proyeksi Koordinat. Sistem 

Proyeksi Koordinat akan memproyeksikan atau mengkonversi data dengan cara yang 

memungkinkan untuk mengubah skala dan memperbaikinya. Maka dari itu, untuk 

menjaga skala tetap konstan, kita harus memproyeksikan kembali data kita 

menggunakan Sistem Proyeksi Koordinat. 

 

 

3.2 Memproyeksikan Kembali “On the Fly” 

Setiap proyek QGIS memiliki Sistem Referensi Koordinat, dan setiap layer data juga 

memiliki Sistem Referensi Koordinat juga. Seringkali Sistem Referensi Koordinatnya 

sama. Tetapi terkadang anda akan menambahkan layer yang tidak sama dengan Sistem 

Referensi Koordinat suatu proyek yang ada, dan anda perlu QGIS untuk mengkonversi 

sehingga dapat dimunculkan bersamaan dengan semua data. Istilah yang kita gunakan 

untuk memproyeksikan ulang adalah on the fly. 

 

catatan 

Proyeksi adalah suatu tindakan mengambil koordinat pada bola (seperti bumi), dan 
memanipulasinya sehingga dapat ditampilkan di permukaan yang datar. 
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1. Untuk mengaktifkan proyeksi  “on the fly” , klik pada tombol status Sistem Referensi 

Koordinat pada status bar di bawah pada jendela QGIS: 

 

2.  Pada kotak dialog yang muncul, klik kotak disebelah Enable “on the fly” CRS 

transformation . 

  

3. Ketik “NSIDC” di dalam kotak Filter. Satu CRS NSIDC EASE-Grid Global akan muncul 

pada list di bawah. 

 
 

4. Klik CRS "NSIDC EASE-Grid Global” , kemudian klik OK. 

5. Perhatikan bagaimana bentuk Indonesia berubah. Semua proyeksi bekerja dengan 

mengubah bentuk yang ada di bumi. 

6. Perbesar pada skala 1:20000000 lagi, seperti sebelumnya. 

7. Geser sekitar peta. 

8. Perhatikan bagaimana skala tetap sama! 
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9. Nonaktifkan proyeksi ulang “on the fly” kembali dengan cara klik kembali pada kotak 

yang sudah diklik di sebelah “Enable ‘on the fly’ CRS transformation”.  

10. Sekarang masukan layer vector “Indonesia.shp” yang lain, lokasinya di folder “QGIS 

Training Data/3_Dasar proyeksi peta/”. Apa yang anda lihat? Layer tidak terlihat! 

Tapi mudah untuk memperbaikinya bukan? 

11. Klik kanan pada layer Indonesia di dalam Layer list. 

12. Klik Perbesar pada Layar. 

OK, sekarang kita melihat Indonesia, tapi dimana seluruh dunia? 

Ternyata kita dapat memperbesar dua layer ini, tetapi kita tidak dapat melihatnya secara 

bersamaan. Hal ini dikarenakan Sistem Referensi Koordinat keduanya berbeda. Layer 

continents dalam derajat, sedangkan layer Indonesia dalam meter. Dengan kata lain, pada 

layer continents mungkin berjarak 8,5 derajat dari khatulistiwa, sedangkan pada layer 

Indonesia mungkin berjarak 900000 meter dari khatulistiwa. 

8,5 derajat dan 900000 meter kira-kira jaraknya sama, tetapi QGIS tidak tahu itu! Salah 

satu dari layer harus di proyeksikan ulang agar sesuai dengan layer yang lainnya. 

Untuk memperbaikinya: 

1. Aktifkan transformasi Sistem Referensi Koordinat “on the fly” seperti sebelumnya. 

2. Perbesar dataset Indonesia. 

Sekarang, karena kedua layer sudah ada di Sistem Referensi Koordinat yang sama, kedua 

dataset saling bertampalan dengan sempurna: 

 

catatan 

Proyeksi ulang 'On the fly' berguna untuk menggabungkan dataset yang Sistem Referensi 

Koordinatnya berbeda. 
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Ketika menyatukan data dari sumber yang berbeda, penting untuk diingat bahwa mereka 

mungkin tidak berada dalam Sistem Referensi Koordinat yang sama. Proyeksi ulang ‘on 

the fly’ membantu anda untuk menampilkan keduanya secara bersamaan. 

3.3 Dataset dengan Sistem Referensi Koordinat yang Berbeda 

QGIS dapat memproyeksikan ulang layers dengan menggunakan ‘on the fly’ sehingga kita 

dapat mengerjakan layer-layer tersebut dalam satu proyek. Tetapi hal tersebut 

membutuhkan waktu lebih banyak bagi komputer kita untuk memproyeksikan ulang 

layer, dan akan memperlambat pekerjaan kita. Selain itu dengan mengaktifkan ‘on the fly’ 

kita masih belum bisa menggunakan shapefile tersebut untuk analisis SIG seperti clip 

atau intersect. Untuk hal ini atau untuk alasan lain, kita dapat memproyeksikan ulang 

Sistem Referensi Koordinat suatu layer dan menyimpannya dengan proyeksi yang baru. 

Mari kita memproyeksikan ulang layer Indonesia sehingga Sistem Referensi 

Koordinatnya sama dengan proyek yang sedang dikerjakan. Untuk melakukan ini, kita 

perlu untuk mengekspor data ke data baru dengan menggunakan proyeksi yang baru. 

1. Klik kanan pada layer Indonesia pada list layer 

2. Pilih “Save As…”  pada menu yang muncul. Kemudian akan muncul kotak dialog 

Save vector layer as…   

3. Klik pada tombol “Browse”  di sebelah Save as Field. 

4. Arahkan untuk menyimpan di “QGIS Training Data/3_Dasar proyeksi peta/” dan 

ketikkan nama untuk layer baru adalah “Indonesia_terproyeksi.shp”. 
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5. Tinggalkan Encoding dalam keadaan tidak diubah. 

6. Ubah nilai Sistem Referensi Koordinat pada layer dengan mengklik ikon “Select 

CRS”  pada sebelah kanan panel. 

 

7. Jendela pilihan Sistem Referensi Koordinat akan muncul. Ketik “4326” pada kotak 

Filter. Kemudian pilih WGS 84 pada sisi paling bawah pada jendela. 

 

8. Klik OK. Anda akan kembali pada jendela Save As… 

9. Pilih kotak di sebelah “Add save file to map” . 

10. Jendela Save vector layer as… akan terlihat seperti ini: 
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11. Klik OK dan setelah beberapa lama, anda akan diberikan notifikasi di atas peta yang 

memberitahukan bahwa prosesnya sudah selesai. 

12. Sekarang layer baru anda Indonesia_terproyeksi akan ditampilkan di panel layer. Jika 

anda mematikan proyeksi ulang ‘on the fly’, layer ini akan tetap menampilkan dengan 

benar, karena layer ini sudah diproyeksikan ulang ke dalam Sistem Referensi 

Koordinat yang sama dengan proyek (dan layer continents). 

 

3.4 Georeferensi Gambar 

Georeferensi adalah proses mengaitkan peta fisik atau gambar raster dari peta dengan 

lokasi spasial dan dapat diterapkan pada jenis objek atau struktur yang dapat dikaitkan 

dengan lokasi geografis, seperti titik penting, jalan, tempat, jembatan, atau bangunan. 

Georeferensi sangat penting untuk membuat citra satelit dan juga gambar raster agar 

dapat di overlay dengan data spasial lainnya, seperti data vector dan data raster. 

Untuk menggeoreferensikan gambar, kita perlu menetapkan titik dengan koordinat 

geografis yang dikenal sebagai titik kontrol. Titik kontrol ini mengacu pada objek yang 

ada di bumi. Koordinat ini diperoleh dengan melakukan survei lapangan. Contohnya, kita 
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perlu menggeoreferensikan foto udara dan kita tahu lokasi objek di dalam foto udara 

dengan lokasi yang sama dengan di bumi. Untuk georeferensi ini, cukup masukan titik 

control dengan koordinat yang kita ketahui dari survey lapang. Kita perlu 4 titik kontrol 

atau lebih untuk menggeoreferensikan gambar. 

Sebelumnya, kita harus mengaktifkan plugin Georeferencer GDAL, dengan cara: 

1. Klik “Plugins”  yang terletak pada bagian atas tampilan QGIS. 

2. Pilih “Manage and Install Plugins…”  

3. Ketik georeferencer pada kotak Search. 

4. Pastikan “Georeferencer GDAL”  dicentang, kemudian pilih Close. 

 

Mari kita mulai untuk menggeoreferensikan gambar yang kita dapat dari Geospasial 

BNPB. 

1.  Pilih “Raster -> Georeferencer → Georeferencer…” 

2. Jendela baru akan muncul. Klik ikon Open Raster di sebelah kiri atas pada jendela. 

 

3. Pilih “peta_krb_merapi_2002.jpg” pada folder “QGIS Training Data/3_Dasar 

proyeksi peta/”, kemudian klik Open. 
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4. Pada pilihan Sistem Referensi Koordinat, ketik “4326” pada kotak Filter, kemudian 

pilih WGS 84 sebagai Sistem Referensi Koordinat. 

5. Sebuah gambar akan muncul pada jendela Georeferencer. 

6. Anda dapat menggunakan perbesar atau menggeser peta menggunakan toolbar 

untuk mempelajari lebih lanjut mengenai peta tersebut. 

 

7. Jika anda perhatikan lebih dekat, anda akan melihat grid koordinat dengan tanda. 

Dengan menggunakan grid ini, anda dapat menentukan koordinat X dan Y dari titik 

dimana grid saling berpotongan. Klik “Add Point”  pada toolbar. 

 

8. Jendela baru akan muncul, masukan koordinatnya. 

Untuk Indonesia, X untuk Bujur (BT) dan Y untuk Lintang (LS). Klik OK. Ini dapat 

menggunakan format derajat decimal (dd,dd), koordinat proyeksi/UTM 

(mmmm,mmm), dan derajat, menit, detik (dd mm ss,ss). Jangan lupa untuk 

menggunakan Negatif ( - ) dalam Y/Lintang untuk area selatan dari khatulistiwa. 
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9. Perhatikan tabel GCP dibawah jendela, terdapat detail dari GCP pertama. 

10. Sekarang, tambahkan sedikitnya 4 GCP yang menyeluruh dari gambar tersebut. Lebih 

banyak titik GCP akan menghasilkan gambar yang lebih akurat. 

 

11. Setelah memasukan 4 atau lebih titik, klik “Transformation Setting”  pada 

toolbar. 

 

 

catatan 

Klik kanan pada tabel GCP untuk menghapus titik GCP atau pilih Delete Control Point pada toolbar diatas 
gambar kemudian gunakan itu untuk mengklik Titik Kontrol di Tabel GCP atau Jendela kerja. 
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12. Kemudian akan muncul jendela Transformation Setting. Ikuti semua pengaturan 

seperti ini: 

 

 

13. Untuk menyelesaikan dan mengekspor peta yang sudah digeoreferencing, klik 

tombol “Start Georeferencing”  pada toolbar utama yang terletak di atas pada 

QGIS Workspace. 

 

catatan 

Dalam QGIS terdapat beberapa metode untuk mengubah gambar, ini adalah linear, Helmert, the 1st, 2nd, 

dan 3rd order polynomials, dan the thin plate spline. Metode transformasi yang berbeda ini 

menginterpretasikan Titik Kontrol anda dengan cara  yang berbeda, dan mengatur bagaimana peta 
disamakan dengan georeferensi peta dasar. 

Untuk yang terbaik, Thin plate spline atau transformasi nomor polynomial yang lebih besar biasanya yang 
terbaik. Tampilannya seperti metode pelapis karet, mengubah titik kontrol tepat ke titik kontrol target, 
dan mengoptimalkan akurasi lokal yang berlawanan dengan akurasi global. 
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14. Georeferencing sekarang sudah selesai dilakukan. Layer yang sudah 

digeoreferensikan akan muncul di layar QGIS. 

 

Mengetahui bagaimana cara untuk menggeoreferensi penting ketika kita ingin 

mendijitasi dari sebuah peta kertas atau sebuah gambar yang belum digeoreferensi. 

Ketika gambar sudah digeoreferensi seperti itu, teknik ini dapat digunakan untuk teknik 

dijitasi yang akan kita pelajari dalam bab berikutnya untuk membuat shapefile vector 

yang dapat digunakan di QGIS dan InaSAFE. 
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Modul 4: Bekerja dengan Data Vektor 

 

Tujuan Pembelajaran: 

● Dapat memahami data vektor 

● Dapat membuat data vektor baru 

● Dapat menambahkan data vektor ke layer panel 

● Dapat mengubah simbologi data vektor 

● Dapat memberikan label untuk data vektor 

 

4.1 Data Vektor 

Data vektor adalah data yang paling sering ditemukan dalam SIG. Data ini 

menggambarkan data geografis dalam bentuk poin yang dapat dihubungkan menjadi 

garis dan poligon. Dalam kata lain, poin, garis dan poligon adalah vektor. 

 

Gambar 1. Data vektor 

Setiap objek pada sebuah dataset vektor disebut sebagai feature atau fitur. Ketika 

menggunakan JOSM, kita menyebutnya sebagai objek, namun dalam terminologi SIG 

mereka disebut feature atau fitur. Sebuah poligon yang merepresentasikan sebuah 

bangunan adalah sebuah fitur, begitu juga sebuah garis yang merepresentasikan sebuah 
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sungai. Setiap fitur memiliki lokasi geografis yang terikat pada data lain yang 

menggambarkan fitur tersebut. 

Satu hal yang perlu diingat, layer QGIS hanya dapat memuat satu jenis fitur. Satu layer 

tidak dapat memuat fitur point dan fitur garis, karena kedua fitur tersebut berbeda jenis.  

Oleh karena itu, jika Anda memiliki sebuah file poligon sekolah dan file lain yang berupa 

point sekolah, maka Anda akan menambahkan mereka sebagai dua layer terpisah. 

Biasanya, layer poligon terletak di paling bawah daftar layer, layer garis terletak di tengah 

dan layer point berada di paling atas, karena susunan layer mempengaruhi tampilan peta. 

Agar poligon tidak menutupi garis dan titik, maka layer poligon diletakkan di paling 

bawah. 

4.2 Membuat Data Vektor 

Untuk membuat data vektor baru, ikuti langkah-langkah berikut: 

1. Buka QGIS Anda. 

2. Pilih menu “Layer ‣  Create Layer ‣New Shapefile Layer” . Akan muncul kotak 

dialog baru seperti gambar di bawah ini. 

 

3. Tentukan jenis fitur yang akan dibuat. Ada tiga jenis fitur yaitu point, garis dan 

poligon. Pilih salah satu, misalnya poligon. 



34 

 

4. Pilih Sistem Referensi Koordinat/SRK (Coordinate Reference System/CRS) yang akan 

digunakan. Secara default, SRK akan terisi WGS84. Jika Anda ingin mengubahnya, klik 

ikon globe dan kemudian cari SRK yang ingin digunakan. 

5. Ketika Anda menambahkan layer vektor baru, tabel atribut hanya memiliki satu 

kolom secara default yaitu kolom id. Kolom ini berisi nomor id untuk setiap fitur. 

Anda dapat menambahkan kolom tambahan ke dalam tabel atribut dengan 

menuliskan nama kolom, menentukan tipe kolom (text, bilangan bulat, bilangan 

desimal, tanggal) dan menentukan panjang kolomnya. Misalnya beri nama field baru 

“keterangan” dengan tipe text dan panjang 80. Setelah itu, klik “Add to fields l ist” . 

Kolom yang baru Anda buat akan muncul di fields list. 

6. Klik OK. Kotak dialog save akan muncul. 

7. Pilih direktori untuk menyimpan data vektor Anda. 

8. Beri nama krb_merapi dan simpan sebagai shapefile (.shp). 

9. Data vektor yang baru saja Anda buat akan muncul di layer panel. 

 

4.2.1 Digitasi Data Vektor 

Digitasi adalah proses pembuatan data vektor digital dari sumber lain, misalnya data 

raster. Untuk memulai digitasi, Anda harus mengaktifkan mode editing terlebih dahulu. 

Software SIG biasanya menyediakan mode terpisah untuk editing, untuk mencegah 

pengguna mengedit dengan tidak sengaja atau bahkan menghapus data penting. 

Mengaktifkan atau menonaktifkan mode editing untuk setiap layer harus secara individu. 

1. Buka raster peta_krb_merapi_2002_modified.tif dengan mengklik ikon ini di 

toolbar sebelah kiri QGIS Anda: 

 

2. Buka data vektor krb_merapi.shp yang sudah Anda buat dengan mengklik ikon ini di 

toolbar sebelah kiri QGIS Anda: 

 

3. Pilih krb_merapi.shp di layer panel Anda. 

 

catatan 

Shapefile adalah format file data spasial yang paling umum digunakan. Shapefile dapat diubah menjadi 

berbagai format lain. Shapefile dapat dibaca oleh banyak software SIG. 
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4. Klik tombol “Toggle Editing”  di toolbar bagian atas untuk mengaktifkan mode 

editing: 

 

5. Jika Anda tidak dapat menemukan tombol tersebut, pastikan bahwa toolbar 

“Digitizing”  diaktifkan. Lihat pada menu “View ‣Toolbars ‣Digitizing 

Toolbar”  dan pastikan “Digitizing Toolbar”  dicentang. 

6. Jika Anda sudah mengaktifkan mode editing, tools digitasi juga akan menjadi aktif. 

Berikut ini adalah tools digitasi untuk fitur poligon: 

 

Fungsi-fungsi tools tersebut dari kiri ke kanan: 

● Toggle Editing: mengaktifkan/menonaktifkan mode editing. 

● Save Layer Edits: menyimpan perubahan yang dibuat pada layer. 

● Add Feature: menambahkan/mendigitasi fitur baru. 

● Move Feature(s): memindahkan satu fitur atau lebih. 

● Node Tool: memindahkan node/titik dari sebuah fitur. 

● Delete Selected: menghapus fitur yang terseleksi/terpilih (hanya aktif jika ada 

fitur yang terseleksi/terpilih). 

● Cut Features: meng-cut/memotong fitur yang terseleksi/terpilih (hanya aktif jika 

ada fitur yang terseleksi/terpilih). 

● Copy Features: meng-copy/menyalin fitur yang terseleksi/terpilih (hanya aktif 

jika ada fitur yang terseleksi/terpilih). 

● Paste Features: mem-paste/menempelkan fitur yang dipotong atau disalin ke 

dalam peta (hanya aktif jika ada fitur yang dipotong atau disalin). 

7. Sebelum Anda memulai digitasi, pergi ke menu “Setting ‣Snapping Options...”  

8. Ubah mode Snapping menjadi “Advanced”  dan centang krb_merapi dengan mode 

to vertex and segment dan isi nilai Tolerance 1 dan ubah Unit nya menjadi piksel. 
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9. Klik OK. 

10. Tambahkan fitur baru dengan mengklik tombol “Add Feature” : 

 

11. Mulai digitasi dengan mengklik kiri satu kali di batas area yang berwarna pink tua. 

12. Lanjutkan mengklik titik-titik di batas area yang berwarna pink tua hingga bentuk 

yang tergambar menutupi area yang berwarna pink tua. Hal ini serupa dengan 

menggambar poligon menggunakan JOSM. 

 

13. Untuk mengakhiri digitasi, klik kanan satu kali. Penggambaran fitur baru pun akan 

selesai dan kotak dialog Feature Attributes akan muncul. 

14. Isi masing-masing kolom atribut sesuai dengan keterangan yang tersedia. 

 

15. Klik OK. 

Jika Anda membuat kesalahan ketika mendigitasi sebuah fitur, Anda dapat mengeditnya 

nanti. Selesaikan dahulu mendigitasinya, baru ikuti langkah berikut: 

 

catatan 

Penting untuk mencentang Avoid intersection jika Anda ingin membuat poligon yang setiap fiturnya 
saling snap atau saling mengikat. 
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● Pilih fitur yang ingin diedit menggunakan tool “Select Feature” : 

 

● Lalu gunakan salah satu tools ini untuk mengedit fitur tersebut: 

 

Move feature(s) tools Memindahkan satu fitur atau lebih 

 

Node tools Memindahkan node/titik dari sebuah fitur 

 
Delete selected Menghapus fitur yang terseleksi/terpilih 

 
Undo Meng-undo kesalahan atau tekan Ctrl + Z pada keyboard 

 

Sekarang coba Anda lakukan sendiri: 

16. Digitasi semua kawasan rawan bencana, dari KRB III, KRB II dan KRB I. Gunakan 

raster peta_krb_merapi_2002_modified.tif untuk membantu Anda mendigitasi dan 

Anda dapat melihat informasi untuk masing-masing warna pada legenda yang berada 

di sebelah kanan. 

 

17. Perlu diingat bahwa setiap fitur baru harus memiliki id yang berbeda. 

Ketika Anda selesai menambahkan fitur pada sebuah layer, jangan lupa untuk 

menyimpan perubahan yang sudah Anda buat. 
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18. Klik tombol “Toggle Editing” . 

19. Akan muncul kotak dialog yang menanyakan apakah Anda mau menyimpan 

perubahan. Pilih Save. 

 

Sekarang Anda sudah mengetahui bagaimana cara membuat fitur poligon. Membuat fitur 

titik dan garis semudah membuat fitur poligon. Tinggal pilih tipe fiturnya ketika 

membuat data vektor baru. 

4.3 Menambahkan Data Vektor 

Seperti yang diebutkan sebelumnya, shapefile adalah format file data spasial yang sering 

digunakan. Format file ini dapat diubah dengan mudah ke dalam format file lain dan 

banyak software SIG yang dapat membaca jenis file tersebut. Ketika menambahkan 

shapefile ke dalam software SIG, Anda mungkin melihat ada beberapa file dengan nama 

yang sama dengan shapefile di direktori tempat Anda menyimpan shapefile. Hal ini 

karena sebuah shapefile didukung dan terikat dengan file lain seperti .shx, .dbf dan .prj 

untuk menyimpan informasi dan pengaturan lain. Ketika Anda menambahkan sebuah file 

shapefile ke dalam software SIG, pilihlah file yang memiliki format .shp. Namun file lain 

juga penting, jadi jangan dihapus. 

● Coba tambahkan layer bangunan_jakbar.shp dengan mengklik ikon  atau dengan 

men-drag/menarik file bangunan_jakbar.shp ke layer panel QGIS Anda. 

● Setelah berhasil menambahkan layer tersebut, tampilan QGIS Anda akan seperti ini: 
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Database 

Shapefile (dan jenis file lainnya) adalah salah satu cara menyimpan data spasial. Anda 

juga bisa memuat layer vektor pada QGIS dari sebuah database. Anda mungkin familiar 

dengan Database Management System (DBMS) seperti Microsoft Access. Aplikasi SIG juga 

memanfaatkan database untuk menyimpan data spasial. Database dapat disimpan dan 

digunakan pada komputer Anda, atau dapat dibagikan antar pengguna menggunakan 

sebuah jaringan atau bahkan internet. 

● Coba tambahkan layer dari sebuah database dengan menekan ikon di bawah ini. Jika 

ikon ini tidak dapat Anda temukan di toolbar sebelah kiri QGIS Anda, pastikan jika 

toolbar “Manage Layers”  diaktifkan. 

 

● Akan muncul sebuah kotak dialog. Klik New. 

 

● Arahkan ke folder dimana file penutup_lahan_jakarta.sqlite berada. Pilih file nya 

dan klik Open. 

● Pada kotak dialog, Anda akan melihat menu dropdown yang sekarang berisi 

penutup_lahan_jakarta.sqlite@..., diikuti dengan direktori file tersebut berada. 

● Klik Connect. Tampilan kotak dialog akan berubah seperti gambar berikut: 
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● Database penutup_lahan_jakarta.sqlite ternyata memiliki sebelas layer berbeda 

yang tersimpan di dalam database tersebut. Pilih semua layer dengan menekan dan 

tahan tombol SHIFT kemudian klik layer pertama dan layer terakhir. 

● Klik Add. Kesebelas layer tersebut akan muncul pada proyek QGIS Anda. 

 

● Layer-layer yang baru saja Anda tambahkan adalah layer poligon. Jika Anda memiliki 

layer titik atau garis yang sedang aktif di layer panel Anda, letakkan layer poligon di 

bagian paling bawah, layer garis di bagian tengah dan layer titik di bagian paling atas 

layer panel Anda agar fitur titik tidak tertutup oleh fitur garis dan poligon dan fitur 

garis juga tidak tertutup fitur poligon. Jika proyek QGIS Anda terdiri dari beberapa 

layer poligon, pastikan layer poligon yang paling besar terletak di paing bawah daftar 

layer agar tidak menutupi poligon yang lebih kecil. Untuk memindahkan layer, 

drag/tarik layer kemudian letakkan pada posisi yang diinginkan. Centanglah pilihan 

“Control rendering order” , jika ada pilihan tersebut di paling bawah daftar layer 

Anda. 

● Untuk menghapus layer yang tidak Anda perlukan, klik kanan pada layer tersebut 

kemudian klik “Remove” . 

● Untuk menonaktifkan layer, hilangkan tanda centang pada kotak yang ada di sebelah 

kiri nama layer. Sebaliknya, untuk mengaktifkan layer, beri centang pada kotak yang 

ada di sebelah kiri nama layer. 

4.4 Simbologi 

Simbologi mengatur tampilan visual dari sebuah peta. Salah satu kekuatan utama dari 

SIG adalah Anda dapat merepresentasikan data dengan visualisasi yang dinamis. Oleh 

karena itu, tampilan visual peta (yang bergantung pada simbologi dari masing-masing 

layer) sangatlah penting. Peta yang Anda buat harus mudah dipahami dan mewakilkan 

data yang dipetakan. Simbologi yang baik sangat membantu Anda ketika Anda mengolah 

dan menggali lebih dalam data tersebut. 

 

catatan 

Simpan secara berkala proyek QGIS Anda (format file .qgs). Proyek QGIS Anda tidak menyimpan 

perubahan pada data Anda (data disimpan dalam shapefile atau database nya), tapi proyek QGIS Anda 

menyimpan layer apa saja yang ditambahkan ke dalam proyek, susunan layer nya, dan pengaturan lain 
yang sudah Anda buat.  
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Dengan kata lain, simbologi yang baik tidak hanya ditujukan agar indah dilihat. Simbologi 

yang baik sangat penting dalam SIG dan dalam menghasilkan peta dan informasi yang 

mudah dipahami dan digunakan. 

4.4.1 Mengubah Warna 

Untuk mengubah simbologi sebuah layer, buka Properties dari layer tersebut. Coba Anda 

ubah warna dari layer bangunan_jakbar. 

1. Klik kanan pada layer bangunan_jakbar di daftar layer Anda. 

2. Pilih “Properties” . 

 

3. Pada jendela Properties, pilih tab “Style” . 

4. Klik pada kolom warna untuk mengubah warna. 

 

5. Sebuah kotak dialog akan muncul. Pilih warna yang sesuai atau yang mewakili objek 

bangunan dan Klik OK. 

6. Klik OK lagi pada jendela Properties, dan Anda akan melihat perubahan tampilan 

warna dari layer bangunan_jakbar. 

 

catatan 

Anda juga dapat mengakses Properties dari sebuah layer dengan mengklik kiri dua kali pada nama layer. 
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4.4.2 Mengubah Struktur Simbol 

Tidak hanya warna layer, Anda juga dapat mengubah strukturnya. Berikutnya Anda akan 

mengubah warna dari layer penutup_lahan_jakarta, menghilangkan garis tepi agar 

terlihat menyatu. 

1. Tambahkan layer penutup_lahan_jakarta ke dalam proyek QGIS Anda. 

2. Buka “Properties”  dari layer penutup_lahan_jakarta. Pada tab “Style” , Anda akan 

melihat kotak dialog yang sama seperti sebelumnya. Namun kali ini, strukturnya juga 

akan diganti. 

3. Klik pada “Simple Fil l”  di bawah panel layer simbol. Akan muncul kolom Symbol 

layer di bawahnya. 

 

4. Ubah warna dengan mengklik kolom warna di sebelah “Fill” . 

5. Pilih warna yang sesuai atau yang mewakili penutup lahan. 

6. Klik OK. 

7. Untuk menghilangkan garisnya, ubah “Outline Style”  dari “Solid Line”  menjadi 

“No Pen” . 

8. Klik OK. Jika Anda melihat tampilan peta Anda, layer vegetasi akan berubah warna 

dan tidak ada garis antar poligon nya. Perhatikan gambar berikut ini, gambar pertama 

adalah tampilan Outline Style dengan tipe Solid Line dan gambar kedua adalah 

tampilan Outline Style dengan tipe No Pen. 
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9. Coba ubah simbologi dari layer tempat_tinggal sehingga tidak memiliki garis outline. 

Untuk berkreasi dengan simbologi peta Anda, Anda dapat mengubah pengaturan berikut 

ini sesuai kebutuhan Anda: 

 Fill Mengubah warna dari isian fitur 

 Outline Mengubah warna garis outline dari fitur 

 Fill style Mengubah style dari isian fitur 

 Outline style Mengubah style dari garis outline fitur 

 Join style Mengubah style dari sambungan antar sudut 

 
Outline width 

Mengubah tebalnya garis outline, ada tiga satuan yang dapat dipilih 

yaitu Millimeter, Pixel dan Map Unit 

 Offset X,Y Mengubah offset fitur dari sumbu X dan Y nya 

 

4.4.3 Mengubah Tampilan Berdasarkan Skala 

Terkadang, salah satu layer pada proyek Anda tidak sesuai dengan skala saat itu. 

Misalnya, Anda punya layer Indonesia, garis Indonesia tersebut mungkin tidak akurat 

ketika Anda memperbesarnya untuk melihat jalan utama di Jakarta. 

 

Pada contoh seperti diatas, mungkin Anda dapat menonaktifkan layer jalan terlebih 

dahulu ketika Anda memperkecil petanya. Layer jalan tidak begitu berguna ketika 

petanya diperkecil karena hanya akan terlihat seperti gumpalan. 

Mari gunakan rendering berbasis skala: 

1. Buka Properties dari layer jakarta_main_road. 

2. Pilih tab “General”. 

3. Aktifkan rendering berbasis skala dengan mencentang Scale dependent visibility. 

Ubah nilai “Maksimum”  menjadi 1:10 dan “Minimum”  menjadi 1:200000. 

 

catatan 

Skala adalah referensi perbandingan jarak pada peta dengan jarak sebenarnya. 

Skala biasanya ditulis 1:10000, yang artinya satu sentimeter pada peta sama dengan 10000 sentimeter 
pada kenyataannya. Ketika Anda memperbesar atau memperkecil tampilan peta, skalanya berubah, 
seperti yang terlihat pada bagian bawah QGIS 
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4. Klik OK. 

5. Coba lihat peta Anda dan coba perbesar dan perkecil. Layer jalan akan muncul ketika 

Anda menggunakan skala besar dan menghilang ketika menggunakan skala kecil. 

 

 

4.4.4 Menambahkan Simbol 

Sekarang Anda telah mengetahui bagaimana mengubah simbol sederhana untuk sebuah 

layer, langkah berikutnya adalah membuat simbologi yang lebih kompleks menggunakan 

layer simbol. 

1. Buka Properties dari layer penutup_lahan_jakarta, kemudian pilih tab “Style” . 

2. Pada contoh berikut, layer penutup_lahan_jakarta tidak memiliki garis outline 

karena sebelumnya sudah Anda ubah style nya menjadi No Pen. 

3. Pada panel layer simbol, klik pada “Fill”  dan klik tanda + di sudut kiri bawah layer 

simbol. 

4. Setelah tanda + diklik, sebuah layer simbol baru akan ditambahkan ke dalam daftar 

layer simbol. 

5. Layer simbol baru mungkin akan tampil dengan warna berbeda. 

 

Sekarang layer penutup_lahan_jakarta memiliki dua simbologi berbeda. Pada contoh di 

atas, layer simbol biru dan layer simbol hijau akan tergambar. Namun, layer simbol biru 

akan tergambar di atas layer simbol hijau dan karena layer simbol biru menggunakan 

“Solid Color”  sebagai “Fill Style”  nya, layer simbol biru akan menutupi seluruh layer 

simbol hijau. 

 

catatan 

Anda dapat menggunakan tombol gulir pada tetikus/mouse. anda untuk memperbesar atau 

memperkecil. Dapat juga menggunakan tool zoom untuk menggambar kotak dan zoom ke kotak 
tersebut. 
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Penting untuk dapat membedakan antara sebuah layer peta dengan layer simbol. Sebuah 

layer peta adalah data vektor atau raster yang sudah dimuat ke dalam proyek QGIS. 

Sebuah simbol layer adalah bagian dari simbologi untuk merepresentasikan sebuah layer 

peta. Pada bab ini, layer peta akan disebut dengan layer, tetapi sebuah layer simbol akan 

disebut dengan layer simbol, agar mudah dibedakan. 

6. Ubah style dari outline layer simbol biru menjadi No Pen. 

7. Ubah “Fill Style”  dari layer simbol biru menjadi selain Solid dan No Brush, misalnya 

“Horizontal” . 

8. Klik OK dan lihat hasil perubahan simbolnya pada peta Anda. 

 

9. Sekarang coba Anda tambahkan layer simbol untuk layer jakarta_main_road dengan 

ketentuan: 

● Ketebalan garis 2.0 untuk layer simbol pertama warna hitam 

● Ketebalan garis 1.0 untuk layer simbol baru warna putih 

10. Hasilnya akan seperti ini: 
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11. Sekarang layer jalan Anda terlihat seperti memiliki garis outline, tapi terlihat tidak 

saling bersambungan. Untuk memperbaikinya, Anda dapat mengaktifkan tingkatan 

simbol. 

12. Pada kotak dialog Properties tab “Style”,  klik “Advance ‣  Symbol levels” : 

 

13. Kotak dialog Symbol levels akan muncul. Beri centang pada “Enable symbol 

levels” . 

14. Tampilan peta Anda akan seperti ini: 

 

4.4.5 Jenis Layer Simbol 

Dalam mengatur warna isian dan menggunakan pola yang sudah ada, Anda dapat 

menggunakan jenis layer simbol yang berbeda. Jenis layer simbol yang sebelumnya Anda 
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gunakan hanyalah jenis Simple Fill. Semakin kompleks jenis layer simbolnya, semakin 

Anda dapat mengkustomisasi simbolnya lebih jauh. 

Masing-masing jenis data vektor (titik, garis dan poligon) memiliki kumpulan jenis layer 

simbolnya sendiri. Berikut ini adalah kumpulan jenis layer simbol dari titik. 

a. Titik 

1. Ubah simbol dari layer poi_jakarta. 

2. Anda dapat mengubah jenis simbol layer dengan mengklik sebuah layer simbol dan 

kemudian klik menu dropdown “Symbol layer type” . 

3. Lihat pilihan jenis simbol layer yang tersedia. Pilih sebuah jenis layer simbol selain 

“Simple Marker.”  Jika Anda ragu memilih yang mana, coba gunakan “Ellipse 

Marker” . 

4. Atur garis outline nya menjadi tipis, misalnya 0.2 mm, pilih warna yang gelap untuk 

isiannya dengan “symbol width”  2.00 dan “symbol height”  4.00. 

 

5. QGIS juga memungkinkan Anda untuk menggunakan file .svg sebagai simbol untuk 

fitur titik. Caranya dengan memilih jenis simbol layer pada symbol layer type: “SVG 

Marker” . Kemudian Anda dapat memilih svg yang sudah disediakan pada kolom SVG 

Image dan mengatur ukuran beserta tata letaknya. Jika Anda memiliki simbol svg 
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sendiri, Anda dapat menggunakannya dengan mengarahkan ke direktori tempat file 

svg tersebut berada dengan mengklik ikon “...”  di bawah kolom SVG Image. 

 

b. Garis 

1. Untuk melihat pilihan simbologi untuk vektor garis, buka Properties dari layer 

jakarta_main_road dan buka tab “Style” . 

2. Tambahkan dua layer simbol pada panel layer simbol dengan mengklik tanda + di 

bawah panel layer simbol. 

3. Klik “Simple line”  yang paling atas pada panel layer simbol dan ubah jenis layer 

simbolnya. Pilih sebuah jenis layer simbol selain Simple line, coba pilih “Marker 

line” . 

4. Klik “Marker line”  pada panel layer simbol dan ubah “marker placement”  nya 

menjadi with interval 2.0 mm. 

5. Setelah itu, klik “Simpel marker”  pada panel layer simbol, ubah warna isian dan 

warna garis outline nya menjadi putih dengan ukuran 1.0 mm. 
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6. Ganti warna layer simbol “Simple line”  yang kedua dengan warna hitam dan lebar 

1.0 mm. 

 

 

7. Ganti warna layer simbol Simple line  yang ketiga dengan warna kuning dengan 

lebar 2.0 mm. Layer jalan Anda akan terlihat seperti ini: 

 

Setelah Anda berhasil mengatur tampilan jalannya, lihat hasilnya. Jika titik-titik putih dari 

marker line tidak terlihat, coba lihat Advance setting pada tab Style di menu Properties. 
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Aktifkan symbol levelnya dan atur layer simbol paling atas (pada contoh ini yang paling 

atas adalah marker line) dan ubah menjadi “2”. Kemudian klik OK. 

8. Coba ubah tampilan dari layer jalan sehingga tampilan jalannya menjadi berwarna 

abu-abu tua atau hitam, dengan garis outline kuning yang tipis dan garis putus-putus 

berwarna putih di tengahnya. 

 

c. Poligon 

1. Sekarang, mari ubah simbologi untuk layer permukiman. Lihat pilihan jenis layer 

simbol yang tersedia untuk vektor poligon. Silakan Anda lihat contoh dari masing-

masing jenis layer simbol tersebut. Untuk contoh kali ini, akan digunakan jenis layer 

simbol Point pattern fill . 

2. Atur layer simbol Point pattern fill  dengan horizontal distance  5.0 mm dan 

vertical distance  5.0 mm. Ubah layer simbol Simple marker dengan warna isian 

abu-abu tua, ukuran 1.0 dan outline style  No pen. 

3. Tambahkan sebuah layer simbol baru dengan mengklik tanda + dan atur jenis layer 

simbolnya menjadi Simple fill . Ubah warnanya menjadi warna yang kontras dengan 

abu-abu, misalnya ungu dan ubah outline style  nya menjadi No pen. 

4. Pindahkan layer simbol Simple fill ke bawah layer point pattern fill menggunakan 

tombol Move down: 

 

5. Properties dari simbol Anda akan terlihat seperti ini: 
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Hasilnya, Anda akan memiliki tampilan yang bertekstur untuk layer permukiman dimana 

Anda bisa mengatur ukuran, bentuk dan jarak dari setiap bulatan yang membentuk 

teksturnya. 

4.4.5 Simbol Terklasifikasi 

Dengan mengklasifikasikan data vektor berdasarkan jenisnya, Anda dapat memberikan 

simbologi berbeda dan mereka akan tetap muncul di layer yang sama. 

 

a. Klasifikasi Data Nominal 

1. Buka Properties dari layer penutup_lahan_jakarta dan pilih tab Style. 

2. Klik menu dropdown Single Symbol: 

 

3. Ubah menjadi Categorized . 

4. Ubah Column menjadi ket dan color ramp menjadi spectral . 

5. Klik tombol Classify . 

6. Setelah itu klik OK. 
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7. Klik tanda panah di sebelah layer penutup_lahan_jakarta, Anda akan melihat kategori 

dari layer tersebut: 

 

Klasifikasi data berdasarkan kategori yang dimiliki layer tersebut sungguh berguna 

untuk membedakan antar kategori pada peta Anda, namun jika dilihat tampilannya 

masih kurang indah. Mari ubah tampilannya agar lebih indah. 

8. Buka lagi Properties dan pilih tab Style. 

9. Klik tombol Change  di samping tulisan Symbol . 

10. Hilangkan garis outlinenya dengan mengklik Simple fill  pada layer simbol dan ubah 

Outline style  nya menjadi No pen. 

11. Klik tombol Delete All  di samping tombol Classify . 

12. Sekarang klik lagi Classify dan simbol baru akan muncul. Simbol baru tidak memiliki 

garis outline karena Anda baru saja menghapusnya. 

13. Ubah warna dari masing-masing tipe penutup lahan dengan mengklik dua kali pada 

kotak warna di samping nama-nama penutup lahannya. Anda dapat mengubah 

warnanya sesuai dengan jenis penutup lahannya misalnya danau akan lebih 

terwakilkan dengan warna biru atau perkebunan akan lebih terwakilkan dengan 

warna hijau. 
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14. Perhatikan bahwa kategori yang paling bawah tidak memiliki nama. Pilih kategori 

kosong ini dan klik tombol Delete. 

 

15. Kemudian klik OK. 

b. Klasifikasi Rasio 

Pada contoh sebelumnya, Anda mengklasifikasikan penutup lahan dengan cara 

klasifikasi nominal. Tipe klasifikasi ini mengklasifikasikan kategori berdasarkan nama. 

Selanjutnya Anda akan melakukan klasifikasi layer penutup_lahan_jakarta berdasarkan 

luas dari masing-masing fitur. Mengklasifikasikan berdasarkan data atribut yang berupa 

angka positif, misalnya area lahan, disebut sebagai klasifikasi rasio . 

1. Buka tabel atribut dari layer penutup_lahan_jakarta. Lihat kolom Luas(Ha). Kolom ini 

memuat data luas area lahan dari fitur-fitur poligon penutup_lahan_jakarta. 

2. Buka Properties dari layer tersebut kemudian klik tab Style. 

3. Ubah tipe Style nya menjadi Graduated  dan gunakan Luas(Ha) pada Coloumn . 

4. Karena pengkategorian kali ini menggunakan angka, sebuah gradasi warna akan 

cocok merepresentasikan kategorinya. Klik “Oranges” pada color ramp. 

5. Klik Classify . 
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6. Hasilnya akan seperti ini: 

 

Sekarang Anda sudah mengetahui bagaimana cara mengatur simbologi data vektor ke 

berbagai jenis. Anda dapat mencoba mengatur simbologi data lain misalnya titik atau 

garis sehingga data vektor Anda menjadi lebih informatif. 

 

4.4.6 Menyimpan Simbol yang Sudah Dibuat 

Ketika Anda telah selesai mengatur simbologi dari peta Anda, Anda dapat menyimpan 

pengaturan simbol ini sehingga Anda tidak perlu mengatur simbol dari awal lagi jika 

ingin menggunakan lagi simbol yang sama persis. 

1. Jika simbologi Anda sudah diatur sedemikian rupa dan ingin menyimpannya, buka 

kembali Properties dari layer tersebut dan buka tab Style. 

2. Klik Style ‣  Save Style ‣  QGIS Layer Style File . 
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3. Beri nama style yang Anda ingin simpan dan klik Save. Anda dapat memuat style yang 

Anda sudah simpan dengan mengklik Style ‣  Load Style . Perlu diingat, jika Anda 

memuat style yang sudah disimpan, maka pengaturan style sebelumnya akan hilang. 

 

 

4.5 Label 

Label dapat ditambahkan ke peta untuk memberikan informasi dari suatu objek. Label 

bergantung pada konten yang ada pada data atribut layer itu sendiri. 

Ada beberapa cara untuk menambahkan label pada QGIS. Anda dapat melihat sebuah tab 

bernama “Labels” ketika membuka jendela Layer Properties dari suatu layer. Tab ini 

berfungsi untuk memberikan label pada peta Anda, namun ada cara lain yang lebih baik 

dengan menggunakan “Label Tool” yang akan kita pelajari pada bagian ini. 

4.5.1 Pemberian Label Titik 
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Sebelum Anda dapat mengakses Label tool, pastikan tool tersebut telah aktif. 

1. Pergi ke item menu View ‣  Toolbars . 

2. Beri tanda centang pada item Label  untuk mengaktifkan tool Label apabila tool 

tersebut belum aktif. Kemudian Label pada toolbar akan terlihat seperti ini: 

 

3. Kik layer POI_Sleman_OSM pada list layer, sehingga layer tersebut terpilih. 

4. Klik pada tombol labelling: 

 

Kemudian akan muncul kotak dialog Layer Syling, kemudia ubah “No labels”  

menjadi “Show labels for this layer”  untuk memunculkan label pada layer. 

 

5. Kita harus menentukan terlebih dahulu kolom atribut mana yang menjadi acuan 

penamaan label. Kolom NAME biasanya digunakan untuk acuan penamaan label, 

untuk itu pilih kolom NAME pada list kolom: 

 

6. Klik Apply. Hasil label peta akan seperti ini: 
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Setiap titik sudah mempunyai label, namun teks tulisan pada label terlihat 

bertumpukan dengan objek garis jalan dan titik serta ukuran teks terlihat lebih 

besar daripada yang diperlukan.  Hal ini kurang terlihat bagus pada peta. Mari kita 

perbaiki bersama masalah ini! 

7. Buka kembali tool Label dengan cara menklik tombol Label . 

8. Kemudian klik pada Tab Teks  untuk merubah pengaturan teks. 

 

9. Font teks standar akan muncul untuk pertama kalinya. Rubahlah font standar 

tersebut menjadi font Arial dengan ukuran teks 8. 

10. Lalu klik pada tab Buffer pada teks. Beri tanda centang pada “Draw text 

buffer” . Fungsi buffer adalah untuk memberikan warna pada garis luar teks 

(outline) sehingga dapat tetap memperjelas teks label apabila bertumpukan 

dengan objek lain dibelakangnya. 
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11. Beri jarak antara titik dan teks label. Klik tab Placement , beri jarak sebesar 

2mm. 

 

Label Anda sekarang akan terlihat seperti ini: 

 

4.5.2 Pemberian Label Garis 

Sekarang Anda telah memahami cara labelling, namun ada masalah lainnya. Titik dan 

poligon mudah untuk diberikan label, tapi bagaimana dengan garis? Jika Anda 

memberikan label dengan cara yang sama dengan cara labelling titik, hasil label Anda 

akan terlihat seperti ini: 
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Label dengan cara tersebut tidak terlalu bagus jika diaplikasikan ke garis, untuk itu kita 

perlu mengedit beberapa pilihan. 

1. Sembunyikan layer POI_Sleman_OSM terlebih dahulu agar tidak menganggu 

proses labelling Anda. 

2. Aktifkan layer Jalan_Sleman_OSM seperti langkah sebelumnya. (Ingat! Gunakan 

tool Label yang ada pada toolbar, bukan pilihan label pada Label Properties.) 

3. Atur ukuran teks menjadi 7 dan aktifkan fungsi buffer sehingga memudahkan 

Anda dalam melihat label. 

4. Perbesar sehingga skala menjadi 1:10000 

5. Pada tabel Placement , pilih pengaturan berikut: 

 

Peta Anda akan terlihat seperti berikut, tergantung dengan skalanya: 
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Hasilnya lebih baik daripada sebelumnya, namun belum ideal. Pada awalnya, beberapa 

nama muncul lebih dari sekali,. Untuk mencegah hal tersebut terjadi: 

6. Pergi ke tab Rendering 

7. Scroll kebawah dan aktifkan pilihan “Merge connected l ines to avoid 

duplicate labels”  

 

Fungsi lain yang berguna adalah untuk mencegah label tergambar untuk fitur garis yang 

terlalu pendek: 

● Tetapkan nilai Suppress labeling  pada fitur yang lebih kecil sampai 5mm dan catat 

hasilnya ketika Anda klik Apply. 

● Coba pula beberapa pengaturan pada tab Placement . Seperti yang telah kita lihat 

sebelumnya, opsi horizontal  tidak terlalu tepat pada kasus ini, cobalah opsi curved . 

● Pilih opsi curved pada tab Placement pada kotak dialog pengaturan labeling layer. 

Hasilnya adalah seperti berikut: 



61 

 

 

Seperti yang Anda lihat, banyak label yang hilang jika dibandingkan hasil sebelumnya 

dikarenakan kesulitan yang terjadi pada pembuatan label agar mengikuti garis jalan yang 

memutar namun tetap terlihat layak. Anda dapat menentukan opsi mana saja untuk 

digunakan, tergantung pada kasus yang Anda temui dan mana yang terlihat lebih baik. 

Sekarang Anda telah mengetahui bagaimana atribut dapat membuat perbedaan visual 

pada peta Anda, bagaimana apabila atribut digunakan untuk merubah simbologi objek 

itu sendiri? Itu merupakan topik materi untuk bagian selanjutnya! 
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Modul 5: Data Attribut 

Tujuan Pembelajaran 

● Memahami apa itu data atribut  

● Memahami tipe-tipe data  

● Melakukan pencarian data menggunakan Field Filter 

● Melakukan pencarian data menggunakan Advance Filter (Expression) 

● Melakukan pencarian dan seleksi data menggunakan Select Features Using an 

Expressions 

● Menambahkan dan menghapus field/kolom pada tabel atribut 

● Menggunakan Field Calculator 

Setelah mempelajari tentang data vektor, pada materi kali ini kita akan 

mempelajari lebih lanjut mengenai apa itu data atribut. Data atribut memberikan 

deskripsi mengenai sebuah data secara kualitatif maupun kuantitatif. Pada materi kali ini, 

kita akan belajar bagaimana melakukan beberapa operasi terkait dengan data atribut, 

mulai dari melakukan pencarian terhadap suatu objek spesifik menggunakan fitur kueri, 

menambahkan dan menghapus field/kolom, hingga fungsi field calculator.  

 

5.1 Apa itu Data Atribut 

 Data atribut merupakan informasi tambahan yang terdapat di dalam sebuah data 

spasial. Jika data spasial menunjukkan informasi mengenai lokasi dimana data tersebut 

berada, maka dengan adanya data atribut kita dapat mengetahui secara lebih spesifik 

mengenai informasi data tersebut. Misalkan kita memiliki suatu titik di dalam peta. Untuk 

mengetahui lebih detil mengenai titik tersebut, kita dapat melihat informasinya di dalam 

data atribut, seperti nama, alamat, ketinggian, dan sebagainya. Untuk dapat melihat data 

atribut pada suatu data spasial, Anda dapat mengikuti langkah-langkah berikut: 

1. Masukkan data vektor menggunakan menu “Layer”  kemudian pilih “Add 

Layer”  dan pilih “Add Vector Layer” . Masukkan data “Jakarta_sekolah 

point.shp”.  
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2. Klik kanan pada data vektor tersebut, kemudian pilih “Open Attribute Table” . 

Anda akan melihat jendela tabel atribut akan terbuka. Tabel-tabel yang berisikan 

angka dan huruf inilah yang dinamakan tabel atribut dari suatu data spasial. 

 

5.2 Tipe-tipe Data  

Berbicara mengenai data atribut, Anda harus mengetahui beberapa tipe data yang 

terdapat di dalam data atribut. Masing-masing tipe data berbeda penggunaannya. 

Adapun untuk tipe data tersebut adalah:  

1. Whole number (integer) 

Menunjukkan tipe data angka bilangan bulat, misalnya angka 1, 10, 100, dan 

sebagainya. Tipe data ini biasa digunakan untuk mendeskripsikan data yang 

memiliki informasi angka bulat, seperti jumlah penduduk, jumlah tempat 

pengungsian, dan sebagainya.  

2. Decimal number (real) 
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Menunjukkan tipe data dengan angka bilangan desimal, misalnya 0.5, 80.7, 120,3, 

dan sebagainya. Tipe data ini biasa digunakan untuk mendeskripsikan data yang 

memiliki informasi angka desimal. Seperti luas area, persentase penduduk miskin, 

dan sebagainya. 

3. Text (string) 

Menunjukkan tipe data teks atau tulisan, misanya nama jalan, nama sekolah, dan 

sebagainya. Tipe data ini biasa digunakan untuk mendeskripsikan suatu hal dalam 

bentuk tulisan, misalnya nama kota, nama SD, nama jalan, dan sebagainya.  

 

5.3 Pencarian Data 

Seringkali ketika kita bekerja dengan data spasial, kita diberikan begitu banyak 

data, sementara tidak semua data tersebut kita butuhkan. Contoh sederhana, misalkan 

kita mempunyai data seluruh sekolah yang ada di Jakarta, namun data yang kita perlukan 

hanyalah data Sekolah Dasar (SD) yang ada di Jakarta. Di dalam QGIS, kita dapat 

menggunakan fitur pencarian data untuk memudahkan kita mencari dan hanya 

memunculkan data yang kita inginkan. Beberapa cara pencarian data tersebut adalah: 

5.3.1 Field Filter 

Fungsi field filter digunakan ketika kita memiliki banyak data, namun kita hanya ingin 

menampilkan data yang kita inginkan saja. Caranya adalah: 

1. Masukkan data Jakarta_sekolah point.shp dengan cara pilih menu “Layer”  

kemudian pilih “Add Layer”  dan pilih “Add Vector Layer” . 

2. Klik kanan pada data vektor, kemudian pilih “Open Attribute Table” . Pada 

layar Anda akan dimunculkan jendela tabel atribut.  

3. Arahkan kursor ke sebelah kiri bawah jendela tabel atribut. Pada menu “Show 

All Features”  klik tanda panah ke bawah dan pilih menu “Field Filter”  
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4. Pilih field/kolom mana yang ingin kita cari. Dalam kasus ini, karena kita mencari 

data SD di Jakarta Selatan, kita pilih “type_id” 

5. Setelah itu, tuliskan objek yang ingin kita cari (SD) di dalam kotak pencarian, lalu 

tekan “Enter”. Maka tabel atribut hanya akan menampilkan data SD yang ada di 

Jakarta.  
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5.3.2 Advance Filter (Expression) 

Fungsi Advance Filter (Expression) memiliki fungsi yang tidak jauh berbeda dengan fungsi 

field filter sebelumnya. Namun yang membedakan adalah pada fungsi ini, user bisa 

memasukkan beberapa parameter sehingga nantinya, data yang akan ditampilkan 

hanyalah data-data yang sesuai dengan parameter ekspresi sql yang mereka masukkan. 

Caranya: 

1. Masukkan data “Jakarta_sekolah point.shp” dengan cara pilih menu “Layer”  

kemudian pilih “Add Layer”  dan pilih “Add Vector Layer” .  

2. Klik kanan pada data vektor, kemudian pilih “Open Attribute Table” . Pada 

layar Anda akan dimunculkan jendela tabel atribut.  

3. Arahkan kursor ke sebelah kiri bawah jendela tabel atribut. Pada menu “Show 

All Features”  klik tanda panah ke bawah dan pilih menu “Advance Filter 

(Expression)” . Akan muncul jendela “Expression based filter”  

 

4. Anda harus menuliskan expression atau rumus kueri sesuai dengan objek yang 

ingin Anda cari. Sebagai bantuan, Anda dapat menggunakan fungsi di bagian 

tengah jendela Expression based filter.  

5. Sebagai contoh, misalkan kita ingin mencari data SMA di Jakarta, maka expression 

yang dapat kita gunakan adalah “type_id” = “SMA”. Cara menambahkannya adalah 

dengan mengklik dua kali pada type_id dalam kategori Fields and Values , 

menambahkan tanda sama dengan (=), kemudian pilih value-nya dengan cara klik 

tombol “all unique”  dan pilih SMA. Setelah semua sesuai, silakan Anda piih 
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tombol OK. Untuk lebih memudahkan Anda, silakan ikuti panduan pada gambar di 

bawah ini. 

 

6. Hasil dari pencarian data akan tampak seperti ini: 
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5.3.3 Select features using an expression  

Fungsi ini digunakan ketika kita menginginkan untuk memilih data dari sekian banyak 

data yang ada dengan menggunakan fungsi ekspresi SQL. Data tersebut nantinya akan 

terpilih pada tabel attribut dan pada kanvas peta akan berwarna kuning. Caranya: 

1.  Buka kembali tabel atribut dari data vektor Jakarta_sekolah point.shp dengan 

cara klik kanan pada layer vektor, kemudian pilih “Open Table Attribute” 

2. Di bagian atas tabel atribut, pilih menu “Select feature using an 

expression”.  Jendela “Select by expression”  akan muncul 

 

3. Masukkan expression sesuai dengan data yang Anda inginkan. Pada kasus ini, kita 

akan mencari data sekolah SMP di Jakarta, maka expression yang dapat kita 

gunakan adalah “type_id” = “SMP”. Cara menambahkannya adalah dengan 

mengklik dua kali pada type_id dalam kategori Fields and Values , 

menambahkan tanda sama dengan (=), kemudian pilih valuenya dengan cara klik 

tombol all unique  dan pilih SMP. Setelah semua sesuai, silakan Anda piih tombol 

“Select” . Setelah Anda klik “Select” , Anda dapat menekan tombol “Close”  

untuk mengakhiri. Supaya Anda tidak bingung, silakan ikuti panduan pada gambar 

di bawah ini. 
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4. Berbeda dengan dua cara pencarian data sebelumnya, fitur Select features 

using an expression  akan menampilkan data yang kita inginkan sekaligus akan 

memilih data tersebut. Hasil pencarian data akan ditampilkan seperti berikut: 

 

Warna biru pada tabel menunjukkan bahwa saat ini tabel atribut hanya memilih 

data sekolah SMP yang berada di Jakarta. Jika Anda melihat pada kanvas peta, 

semua atribut yang dipilih ini akan berwarna kuning. Untuk membatalkan pilihan 

atau menghilangkan warna biru pada tabel, Anda dapat memilih tombol 

“Deselect all” .  
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5.3.4 Filter 

Fungsi filter ini tidak terletak pada saat ketika kita membuka atribut tabel dari sebuah 

data vektor. Fungsi filter ini bertujuan untuk menyaring data secara keseluruhan sesuai 

dengan input dari user. Nantinya geometri data vektor yang ditampilkan hanya data 

vektor yang sesuai dengan input filter dari user, hal yang sama juga terjadi pada tabel 

atribut. Tabel atribut yang ditampilkan hanyalah tabel atribut yang sesuai dengan input 

dari user. Caranya: 

1. Klik kanan pada layer vektor “Jakarta_sekolah point.shp”, kemudian pilih menu 

“Filter”  

 

2. Pada layar akan muncul jendela Query Builder.  Sama dengan fitur pencarian 

sebelumnya, pada jendela ini Anda diharuskan untuk memasukkan rumus untuk 

dapat mencari dan memilih data yang Anda inginkan.   

3. Kali ini kita akan mencoba mencari data sekolah SMK yang berada di Jakarta. 

Rumus yang harus dimasukkan adalah “type_id” = “SMK”. Cara menambahkannya 

adalah dengan mengklik dua kali “type_id” di bawah menu Fields , kemudian 

tambahkan tanda sama dengan (=), kemudian klik “Sample”  dan pilih SMK. 

Untuk melihat hasil pencarian tanpa menutup jendela Query Builder, pilih tombol 

“Test”,  sedangkan untuk melihat hasil pencarian dan menutup jendela Query 

Builder, pilih tombol OK.  
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4. Kanvas peta hanya akan menampilkan data sekolah SMK yang berada di Jakarta. 

5. Untuk memunculkan kembali seluruh data, Anda dapat membuka kembali jendela 

Query Builder  dengan klik kanan pada layer vektor, kemudian pilih Filter, lalu 

Anda pilih tombol Clear  dan tekan OK . 

 

 

 

 

 

Catatan 

Expression yang dimasukkan harus memenuhi aturan syntax, jika tidak maka 

hasil pencarian akan memperlihatkan syntax error pada output preview. 

Namun Anda tidak perlu khawatir, QGIS akan membantu Anda memasukkan 

expression yang memenuhi aturan syntax. Di bawah ini adalah aturan syntax 

umum: 

 Operasi harus dituliskan tanpa format spesial tertentu 

 Penulisan field harus diawali dan diakhiri dengan tanda petik ganda, 
misalnya “nama_objek” 

 Text (string)harus diawali dan diakhiri dengan tanda petik tunggal, 

misalnya ‘Sekolah’ 

 Whole number (integer) dan decimal number (real) harus ditulis tanpa 
awalan dan akhiran, misalnya 120 



72 

 

5.4 Editing Data Atribut 

5.4.1 Menambahkan dan Menghapus Field/Kolom 

Terkadang tidak semua data dalam tabel atribut kita perlukan, sebaliknya, terkadang 

data yang kita perlukan justru belum tercantum di dalam tabel atribut. Kita dapat 

menambahkan atau menghapus field/kolom jika kita merasa banyak sekali kolom yang 

tidak terpakai, sebaliknya kita dapat menambahkan field/kolom jika kita ingin 

menambahkan informasi di dalam tabel atribut. Untuk dapat melakukannya, langkah 

yang harus dilakukan adalah sebagai berikut: 

1. Masukkan data Jakarta_sekolah point.shp dengan cara pilih menu “Layer”  

kemudian pilih “Add Layer”  dan pilih “Add Vector Layer” . 

2. Buka tabel atribut dari data vektor yang telah dimasukkan dengan cara klik kanan 

pada data vektor, kemudian pilih “Open Attribute Table” . 

3. Untuk menambahkan atau menghapus field/kolom Anda harus mengaktifkan 

mode editing dengan cara mengklik tombol “Toogle editing mode”  di sebelah 

kiri atas tabel atribut.  

 

4. Untuk Menambahkan kolom, klik menu “New Field” . Jendela Add Field  akan 

dimunculkan. Silakan Anda isi nama kolom pada pada bagian Name . Sesuaikan 

juga tipe data yang ingin digunakan (lihat bagian 5.2). Kali ini kita akan 

menambahkan kolom alamat di dalam tabel atribut ini. Jika sudah selesai, klik OK. 
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5.  Anda sudah berhasil menambahkan kolom alamat. Anda dapat mengisi kolom 

tersebut dengan data yang diinginkan. Jika sudah selesai menambahkan data, 

jangan lupa simpan hasil pekerjaan Anda dengan mengklik tombol “Toogle 

editing mode”  dan pilih “Save” . Selamat, Anda telah berhasil menambahkan 

kolom baru! 

 

6. Untuk Menghapus Kolom, klik tombol “Delete Field”  di sebelah atas tabel 

atribut. Jangan lupa untuk mengaktifkan “Toogle editing mode”  terlebih 

dahulu. Akan muncul jendela Delete Fields . 
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7. Pilih kolom mana yang ingin Anda hapus. Contoh kali ini kita akan menghapus 

kolom SDT, SDN, dan Alamat. Klik pada kolom yang ingin dihapus, kemudian pilih 

tombol OK untuk mengakhiri. 

8. 3 kolom yang berada di sebelah kanan telah terhapus. Pilihan untuk menghapus 

kolom tidak dapat dibatalkan, jadi pikirkan baik-baik sebelum Anda menghapus 

kolom! 

 

 

5.4.2 Menggunakan Field Calculator 

QGIS memungkinkan kita untuk melakukan operasi penghitungan data yang ada di dalam 

tabel atribut. Fitur ini dinamakan Field Calculator. Dengan adanya Field Calculator, kita 

dapat menghitung formula tertentu untuk data yang jumlahnya sangat banyak. Misalkan 

Anda diminta untuk menghitung jumlah siswa dan siswi untuk setiap sekolah yang ada 

di Jakarta. Tentu akan sangat merepotkan jika Anda harus menghitung satu per satu data 

yang jumlahnya ratusan atau mungkin ribuan. Fitur Field Calculator  akan membuat 

hal tersebut dapat diselesaikan secara lebih mudah.  

Anda dapat mengakses fitur Field Calculator melalui dua cara, Pertama, Anda dapat 

membuka tabel atribut (“Open Attribute Table”) dari data yang ingin anda hitung, 

kemudian pilih menu “Field Calculator”  di bagian atas tabel atribut. Cara kedua, Anda 

dapat langsung mengakses tombol “Field Calculator”  pada toolbar di bagian atas 

kanvas peta. Setelah memilih Field calculator , maka akan muncul jendela Field 

Calculator. Terdapat beberapa bagian yang perlu Anda perhatikan pada jendela Field 

calculator.  
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● Pengaturan field: Pada bagian ini, Anda bisa mengatur field mana yang akan 

memuat hasil kalkulasi. Ada beberapa pilihan yang dapat Anda lakukan: 

o Create a new field: membuat field baru yang akan memuat hasil kalkulasi 

o Update existing field: memperbarui field yang sudah ada dengan hasil 

kalkulasi 

o Create virtual field: membuat sebuah virtual field yang tidak akan disimpan 

ke dataset peta 

● Daftar fungsi: Daftar ini berisi fungsi yang tersedia untuk dimasukkan ke dalam 

kolom Expression. Fungsi-fungsi ini dikelompokkan menjadi beberapa kategori 

sesuai dengan kemiripan fungsi. Untuk menggunakannya, klik dua kali pada fungsi 

yang ingin digunakan di kolom expression 

● Gambaran fungsi: Bagian ini berisi gambaran dari fungsi-fungsi yang terdapat di 

daftar fungsi  

● Operasi Matematik: Akses tombol cepat untuk operasi matematik umum dan 

sering digunakan dalam expression. Operasi ini juga tersedia di daftar fungsi pada 

kategori “Operations”.   

● Expression: Kolom expression memuat formula yang akan dikalkulasikan pada 

field yang telah ditentukan. Formula ini bisa diatur sesuai dengan keinginan dan 

kebutuhan Anda. Di bawah kolom ini terdapat “Output preview” kita dapat melihat 

perkiraan hasil yang akan dihasilkan dari formulasi yang telah dibuat. Anda akan 
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diberikan peringatan jika formula yang Anda masukkan salah serta informasi 

tentang kesalahan tersebut.  

Misalkan Anda memiliki data jumlah penduduk laki-laki dan perempuan di masing-

masing desa di Kabupaten Kudus, Jawa Tengah. Untuk mendapatkan total jumlah 

penduduk masing-masing desa, Anda harus menjumlahkan data penduduk laki-laki dan 

penduduk perempuan. Anda tidak perlu menghitungnya secara manual, yang perlu Anda 

lakukan adalah sebagai berikut: 

1. Masukkan data “Penduduk_Kudus_2014.shp” ke dalam QGIS menggunakan 

pilihan menu “Layer” kemudian pilih “Add Layer”  dan pilih “Add Vector 

Layer” . 

2. Klik kanan pada layer kemudian pilih “Open Attribute Table”.  Dapat Anda 

lihat bahwa pada kasus ini, kita memiliki data jumlah penduduk laki-laki dan 

perempuan masing-masing desa di Kabupaten Kudus.  

 

3. Pilih menu “Field calculator”  pada toolbar di bagian atas tabel atribut 

 

4. Pada jendela Field calculator  Anda harus melakukan beberapa pengaturan 

pada bagian pengaturan field. Pilih “Create a new field”  untuk membuat 

kolom baru (kolom jumlah penduduk). Pada “Output field name”  silakan tulis 

judul kolom sesuai keinginan. Pada pilihan “Output field type”  pilih Whole 
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number (integer), kemudian untuk “Output field length”  sesuaikan dengan 

jumlah karakter angka yang diinginkan (dalam beberapa kasus, 10 sudah cukup).  

5. Silakan Anda tulis expression sesuai dengan yang Anda butuhkan. Dalam kasus ini, 

kita perlu mendapatkan data jumlah penduduk masing-masing desa di Kabupaten 

Kudus. Untuk itu, kita perlu menjumlahkan jumlah penduduk laki-laki dengan 

jumlah penduduk perempuan. Untuk itu, formula yang harus kita tulis pada kolom 

expression adalah: “Laki-laki” + “Perempuan”. Untuk memudahkan Anda, silakan 

ikuti langkah-langkah yang tertera pada gambar berikut:  

 

 

6. Tabel atribut akan memunculkan hasil penjumlahan pada kolom di sebelah kanan. 

Jangan lupa untuk menyimpan hasil penghitungan dengan menekan tombol 

“Save”  pada toolbar di bagian atas tabel atribut.  
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Data atribut berperan penting untuk memberikan informasi terhadap data spasial. 

Sangat penting untuk dapat mengerti mengenai data atribut dan bagaimana cara 

mengolah data atribut sesuai dengan yang kita inginkan. Pada materi ini Anda telah 

berhasil mempelajari apa itu data atribut, melakukan pencarian data, hingga melakukan 

penghitungan sederhana menggunakan Field Calculator.  
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Modul 6: Analisis Vektor 

Tujuan Pembelajaran: 

● Memahami proses pada analisis vektor jenis buffer 

● Memahami proses pada analisis vektor jenis dissolve 

● Memahami proses pada analisis vektor jenis clip 

● Memahami proses pada analisis vektor jenis union 

● Memahami proses pada analisis vektor jenis intersect  

● Memahami fungsi dan praktik alat geoprosesing pada QGIS 

 

6.1 Buffer 

Buffer biasanya digunakan untuk mewakili suatu jangkauan pelayanan ataupun luasan 

yang diasumsikan dengan jarak tertentu untuk suatu kepentingan analisis spatial. 

Pembuatan buffer membutuhkan penentuan jarak dalam satuan yang terukur (meter 

atau kilometer). Dalam melakukan analisis buffer, sebaiknya data vektor yang akan 

diproses harus dalam sistem proyeksi UTM. Fungsi buffer dapat diaplikasikan pada 

analisis untuk mengetahui dampak dari jangkauan wilayah suatu objek. Buffer dapat 

dilakukan pada semua tipe data vektor, yaitu titik, garis, dan poligon. Sebagai contoh, 

analisis lokasi bangunan yang mempunyai akses yang mudah yaitu bangunan yang 

berada dalam jangkauan 50 meter dari jalan utama. 

  

Langkah-langkah untuk melakukan buffer, diantaranya: 

1. Masukkan layer vektor yang akan dilakukan analisis buffer, misalnya layer Jalan. 

Pastikan layer yang akan dilakukan buffer telah memiliki sistem proyeksi 

Universal Transverse Mercator (UTM) dengan satuan meter. 
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2. Kemudian pilih “Geoprocessing Tools”  pada toolbar “Vector”  dan pilih 

“Fixed Distance Buffer” . 

 

3. Akan muncul kotak dialog. Pada kotak dialog ini Anda harus memilih layer yang 

akan dilakukan buffer pada Input layer. Selain itu, Anda perlu memasukkan jarak 

jangkauan buffer yang diinginkan, misal 50 meter. Simpan file hasil buffer dengan 

nama file baru. Lalu klik Run. 
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4. Hasil jalan yang telah dilakukan buffer adalah sebagai berikut: 

 

Seperti yang Anda lihat, jalan tersebut berhasil di-buffer namun ada sedikit 

masalah pada hasilnya yaitu hasil buffernya tidak terlalu rapih. Buffer yang 

dihasilkan sesuai dengan segmen-segmen jalan. Untuk itu, Anda perlu mengulang 

proses buffer dan memberi centang pada pilihan “Dissolve Result”  agar hasil 

segmen jalan tergabung dan rapi. 
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Maka hasil buffer akan terlihat seperti berikut:  

 

6.2 Dissolve 

Dissolve digunakan untuk menggabungkan objek dalam sebuah layer yang mempunyai 

nilai atau isi field tertentu yang sama. Fungsi dissolve ini akan meng-agregasikan 

(menggabungkan) fitur yang memiliki kesamaan nilai pada atributnya. Fungsi dissolve 

biasa digunakan untuk membuat peta yang lebih tidak detil dari suatu peta yang lebih 

detil. Contohnya membuat peta administrasi kabupaten/kota utuh yang berasal dari peta 

kota yang terpecah-pecah dalam kecamatan-kecamatan atau membuat peta subregion. 
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Langkah-langkah dalam melakukan dissolve adalah sebagai berikut: 

1. Masukkan layer yang akan dilakukan dissolve. Sebagai contoh, layer batas 

administrasi desa yang bernama Batas_Desa_Padang yang akan di-dissolve 

sehingga tergabung menjadi batas administrasi kota Padang saja. Pastikan layer 

tersebut mempunyai isi field yang sama sebagai kolom acuan penggabungan yang 

akan dilakukan. 

   

 

2. Klik toolbar “Vector”  pilih “Geoprocessing Tools”  dan pilih “Dissolve” . 

Akan muncul kotak dialog. Pilih input layer yang akan digabungkan yaitu 

Batas_Desa. Lalu, pilih field yang akan dijadikan acuan untuk penggabungan, 

yaitu field KAB_KOTA. Simpan hasil dissolve dengan nama file baru. Lalu klik Run. 
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3. Hasil proses penggabungan menghasilkan batas administrasi kota Padang seperti 

gambar di bawah ini. 

 

6.3 Clip 

Operasi clip digunakan untuk memotong atau menggunting layer. Namun atribut dari 

input layer tidak berubah, hanya bentuk featurenya saja yang mengikuti bentuk layer 

pemotongnya. Layer pemotong (clipper) harus layer polygon, sementara input layer bisa 

dengan tipe point, line maupun polygon. 



85 

 

 

Langkah-langkah dalam melakukan clip, yaitu. 

1. Masukkan dua buah layer yang merupakan layer pemotong (clipper) dan layer 

input yang akan dipotong. Pada contoh kali ini layer Jalan sebagai input layer yang 

akan dipotong dan Batas_Administrasi sebagai layer pemotong. Pastikan kedua 

layer memiliki sistem proyeksi yang sama. Kamudian klik toolbar “Vector” , pilih 

“Geoprocessing Tools”  kemudian pilih “Clip” . 

 

2. Akan muncul kotak dialog. Tentukan layer mana yang menjadi layer input dan 

layer pemotong (clip layer). Simpan hasil clip dengan nama file baru. Lalu klik Run. 
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3. Proses clip akan menghasilkan layer jalan (layer input) yang terpotong 

menyesuaikan layer bentuk poligon batas administrasi (layer pemotong). 

 

6.4 Union 

Operasi union digunakan untuk menggabungkan dua atau lebih layer. Output layer yang 

dihasilkan merupakan gabungan dari kedua layer, berikut atribut datanya. Pada operasi 

ini kedua layer baik input layer maupun overlay layer harus merupakan layer dengan tipe 
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polygon. Hasil output layer nantinya akan memiliki atribut dari gabungan atribut kedua 

layer tersebut dan bentuk geometris hasil gabungan kedua layer pula. 

 

Langkah-langkah dalam melakukan Union, diantaranya: 

1. Masukkan dua layer yang akan digabung, misalnya layer Bangunan dan layer 

Batas_Admin_Olo. Pilih “Union”  pada pilihan “Geoprocessing Tools” . 

 

2. Akan muncul kotak dialog. Karena atribut batas administrasi akan digabungkan 

dengan atribut bangunan, maka tentukan layer Batas_Admin_Olo sebagai input 

layer dan layer Bangunan sebagai input layer 2. Simpan hasil Union dengan nama 

file baru dan klik Run. 
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3. Hasil output Union merupakan hasil geometri gabungan (overlay) dari kedua 

layer beserta gabungan atribut kedua layer tersebut. 

  

6.5 Intersect 

Operasi intersect digunakan untuk memotong input layer dan secara otomatis meng-

overlay antara layer yang dipotong dengan  layer pemotongnya. Pada operasi ini kedua 

layer baik input layer maupun intersect layer harus merupakan layer dengan tipe 

polygon. Sedikit berbeda dengan proses Union, output layer yang dihasilkan akan 
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memiliki atribut gabungan dari kedua layer dan mempunyai bentuk geometris hasil 

irisan kedua layer. 

 

Langkah-langkah dalam melakukan intersect, diantaranya: 

1. Masukkan dua layer yang yang akan di-intersect, misalnya layer Bangunan dan 

Batas_Admin_Olo. Pilih “Intersection”  pada pilihan “Geoprocessing Tools” . 

 

2. Akan muncul kotak dialog. Karena atribut batas administrasi akan digabungkan 

ke dalam atribut bangunan dan layer bangunan tersebut sebagai outputnya, maka 

tentukan layer Batas_Admin_Olo sebagai input layer dan layer Bangunan 

sebagai overlay layer. Simpan hasil intersect dengan nama file baru dan klik Run. 
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3. Hasil dari intersect kedua layer tersebut adalah layer Bangunan (overlay layer) 

yang telah mempunyai atribut batas administrasi tanpa menyertakan layer batas 

administrasi itu sendiri. 

 

   

Sekarang Anda telah mengetahui jenis-jenis analisis vektor yang biasa digunakan pada 

Geoprocessing Tools. Proses analisis vektor ini dapat Anda gunakan sesuai dengan 

kepentingan Anda. 
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Modul 7: Bekerja Dengan Data Raster 

Tujuan Pembelajaran 

● Memuat Data Raster 

● Mengubah Simbologi Raster 

● Analisis Daerah 

Sejauh ini, kita lebih sering bekerja menggunakan data vektor, yang terdiri atas fitur titik 

dan garis. Pada bab ini, kita akan mempelajari tentang data raster. Apakah anda ingat 

ketika anda menambahkan data OpenStreetMap di JOSM? Titik, garis, dan poligon yang 

anda gambar adalah data vektor, tetapi ketika kita memuat citra udara Bing pada bagian 

belakangnya, itu adalah data raster. Jadi, apa perbedaannya? 

Data raster pada dasarnya berasal dari bentuk gambar yang terdiri atas piksel-piksel, 

seperti foto. Gambar raster akan selalu memiliki ukuran lebar piksel dan tinggi piksel. 

Jika anda perbesar data raster cukup jauh, gambar akan terlihat lebih buram dan tidak 

jelas, sama seperti ketika anda membuka foto di komputer anda dan memperbesar foto 

itu dengan sangat dekat. Seperti yang akan kita pelajari dalam bab ini, gambar raster 

dapat berarti lebih dari sekedar foto udara. Ikuti bersama dan kita akan belajar semua 

tentang raster! 

7.1 Memuat Data Raster 

Tidak semua data raster berasal dari foto udara. Terdapat banyak bentuk dari data raster 

dan dalam beberapa kasus, sangat penting untuk mensimbolkan data sehingga menjadi 

lebih terlihat jelas dan berguna. Dalam sesi ini, kita akan menambahkan data raster dan 

bagaimana cara untuk mengubah simbologi. 

1. Klik tombol “Load Raster Layer” : 

 

2. Kotak dialog Load Raster Layer akan muncul. Cari file yang bernama 

popmap10_all.tif. Klik Open. 

3. Ketika sudah muncul di kotak Layer, klik kanan pada judul tersebut kemudian klik 

“Rename” . Ubah nama menjadi Indonesian Population. 
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Ketika sudah dimuat, anda akan melihat gambar raster yang berupa seluruh pulau di 

Indonesia yang berwarna abu-abu. 

 

Layer yang muncul berwarna abu-abu (dan tidak memberikan kita informasi apa-apa) 

karena simbologinya belum kita ubah. Sehingga jika anda memuat gambar raster dan 

hanya menunjukkan kotak berwarna abu-abu, berarti anda tahu bahwa gambar raster 

tersebut belum disimbologi dan masih perlu untuk ditetapkan. Inilah yang akan kita 

lakukan selanjutnya. 

7.2 Simbolisasi Data Raster 

1. Klik kanan pada layer Indonesian_population, pilih Properties, kemudian akan 

muncul jendela Layer Properties. 

2. Pilih Style tab, kemudian akan muncul pengaturan simbologi yang saat ini digunakan 

dan yang kita lihat sebelumnya. 

3. Ubah “Render type”  menjadi “Singleband pseudocolor” . Ubah warna menjadi 

YlOrBr dan ubah “Mode”  menjadi “Equal Interval”  dengan 6 Classes. Klik 

“Classify”  untuk menunjukkan 6 kelas. Dapat dilihat seperti di bawah ini: 

 

catatan 

Resolusi tinggi dan data mengenai distribusi populasi manusia adalah syarat utama untuk 

mengukur dampak pertumbuhan populasi secara akurat, untuk memantau perubahan dan 
untuk merencanakan intervensi. Proyek AsiaPop yang dimulai pada bulan April 2011 

bertujuan untuk menghasilkan peta distribusi populasi manusia di seluruh Asia secara 
gratis. 
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4. Klik OK. Gambar Raster akan terlihat seperti di bawah ini: 

 

Bagus! Gambar raster yang sudah disimbologi menjelaskan bahwa terdapat data pada 

layer tersebut. Hanya dengan melihat gambar tersebut, kita mendapatkan gambaran 

bahwa Pulau Jawa memiliki nilai populasi yang lebih tinggi dibandingkan dengan pulau 

lain.  
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Mari kita pikirkan dan pahami apa yang terjadi. Ingat bahwa gambar tersebut terbuat 

dari piksel-piksel, setiap pikselnya terdapat nilai tersendiri, yaitu nilai warna. Contohnya, 

jika anda memperbesar foto anda dapat melihat setiap pikselnya seperti ini: 

 

Nilai dari setiap sel tersimpan dalam file. Bayangkan file tersebut disimpan seperti ini, 

dimana setiap kotak terdapat masing-masing piksel: 

 

Tentu saja computer tidak mengerti kata-kata untuk warna. Sebenarnya nilai dari setiap 

sel berupa angka yang dimana computer berasosiasi dengan warna tertentu. Untuk foto 

udara sudah ditentukan. Karena gambar ini adalah gambar normal, jadi disetiap 

pikselnya terdapat angka dengan warna yang sering kita lihat setiap hari dan tersimpan 

di dalam file. Tapi gambar raster yang baru kita ubah ini berbeda, karena setiap pikselnya 
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tidak mewakili warna tetapi mewakili populasi, dan QGIS tidak bisa secara otomatis 

menampilkan itu. Maka dari itu, setiap piksel pada gambar hanya diindentifikasi sebagai 

warna abu-abu, walaupun nilai dari piksel-piksel itu berbeda. Ketika kita mengubah 

simbologi menjadi Pseudocolor, kita dapat melihat semua perbedaan nilai piksel yang 

ditunjukkan dengan warna yang berbeda. 

Akan lebih baik jika kita memilih spektrum abu-abu untuk layer Indonesian_population 

dibandingkan dengan memilih banyak warna. Selanjutnya kita akan mensimbolisasikan 

layer dengan spektrum abu-abu, dimulai dari nilai piksel paling rendah hingga nilai piksel 

paling tinggi. Dengan kata lain, jika nilai piksel terlihat seperti ini: 

 

QGIS akan membuat spektrum persamaan angka seperti ini: 

 

 

 

Dan akan membuat gambar seperti ini: 
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Untuk dapat melakukan seperti itu, mari kita mulai mensimbolisasi Indonesian 

Population. 

1. Buka Layer Properties kembali. 

2. Kembalikan “Render type”  menjadi “Singleband grey (1)” . 

3. Di sebelah “Contrast enhancement”  pilih “Stretch to MinMax (2)” . 

4. Pilih “Min/Max”  pada “Load min/max values (3)” . 

5. Pada “Accuracy” , pilih “Estimate (faster) (4)” . 

6. Klik “Load (5)” . 

 

Perhatikan bagaimana nilai max dan min telah berubah. Nilai piksel terendah pada file 

gambar ini adalah 0 dan yang tertinggi adalah 617,578. Tapi berapakah nilai minimum 
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dan maksimum yang harus digunakan? Nilai saat ini yang diberikan pada kita hanya 

kotak abu-abu. Sebagai gantinya, kita harus menggunakan nilai piksel yang sebenarnya 

pada gambar. Anda dapat menentukan nilai tersebut dengan mudah dengan cara memuat 

nilai minimum dan maksimum dari raster tersebut. 

7. Klik OK. Anda dapat melihat nilai dari raster yang ditampilkan, dengan warna yang 

lebih gelap memperlihatkan bahwa jumlah populasinya sedikit dalam setiap 

pikselnya, sedangkan untuk warna yang lebih terang memperlihatkan populasi yang 

lebih banyak pada setiap pikselnya: 

 

Kita telah mempelajari melakukan simbologi dengan cara yang rumit, tapi apakah kita 

bisa melakukannya dengan cara yang lebih cepat? Tentu bisa! Sekarang anda mengerti 

apa saja yang harus dilakukan, anda akan senang ketika tahu ada sebuah cara untuk 

melakukannya dengan cara yang lebih mudah. 

1. Hapus Indonesian_population dari Layer Panel dengan cara klik kanan kemudian 

pilih “remove” . 

2. Muat kembali gambar raster tersebut, ganti nama kembali menjadi 

Indonesian_population seperti sebelumnya. Hasilnya akan menjadi kotak abu-abu 

kembali. 

3. Aktifkan tool yang akan anda perlukan dengan cara “View → Toolbars → 

Raster” . Nanti akan muncul tombol dengan tampilan seperti ini: 
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Tombol di sebelah kanan akan membentang ke nilai minimum dan maksimum untuk 

memberikan anda kontras terbaik di area lokal yang anda perbesar. Hal ini sangat 

membantu untuk data yang besar. Tombol yang di sebelah kiri dapat membentang nilai 

minimum dan maksimum untuk nilai konstan di seluruh gambar. 

4. Klik tombol yang di sebelah kanan (“Stretch Histogram to Full Dataset”). 

Anda akan melihat datanya akan sama seperti yang sudah kita kerjakan sebelumnya! 

7.3 Analisis Daerah 

Beberapa jenis data raster memungkinkan anda untuk mendapatkan lebih banyak 

wawasan mengenai daerah pada data raster tersebut. Digital Elevation Model (DEM) 

sangat berguna dalam hal ini. Dalam sesi ini kita akan melakukan dengan raster DEM 

untuk mencoba mencari tahu lebih banyak informasi dari data raster tersebut. 

7.3.1 Menghitung hillshade 

DEM pada peta anda memang menunjukkan ketinggian dari suatu daerah, tetapi 

terkadang terlihat sedikit abstrak. Data raster tersebut memiliki informasi data 3D 

mengenai daerah tersebut, tetapi tidak terlihat tiga dimensi. Untuk mendapatkan 

tampilan yang lebih baik pada daerah tersebut, kita dapat menghitung hillshade, yang 

dimana data raster tersebut menggunakan cahaya dan bayangan untuk membuat gambar 

terlihat menjadi tiga dimensi. 

Untuk bekerja menggunakan DEM, kita akan menggunakan alat analisis “DEM (Terrain 

Models)” . 

1. Buka file yang bernama SRTM_Merapi.tif, yang berlokasi di QGIS Training 

Data/7_Bekerja dengan data raster/. 

2. Ketika muncul di Layer panel, ganti nama menjadi DEM. 

3. Klik “Stretch Histogram to Full Dataset”  (sama seperti pada bagian 

sebelumnya). 

4. Klik “Raster → Analysis → DEM (Terrain Models)”… Pastikan plugin GDAL 

aktif. 
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5. Pada kotak yang muncul, pastikan Input file yang terisi adalah layer DEM. 

6. Atur Output file menjadi hillshade.tif di QGIS Training Data/7_Bekerja dengan 

data raster/. 

 

7. Centang kotak di sebelah “Load into canvas when finished” . 

 

8. Pastikan Mode yang dipilih adalah mode “Hillshade” . 

9. Lewati pengaturan lainnya tanpa diubah. 

10. Klik OK untuk menghasilkan hillshade. 

11. Ketika proses selesai, klik OK pada notifikasi. 

12. Klik Close pada kotak. 

Saat ini terdapat layer baru yang disebut hillshade yang terlihat seperti di bawah ini: 
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Data raster tersebut terlihat lebih tiga dimensi, tapi apakah kita bisa memperbaikinya? 

Ketika anda membuka alat DEM (Terrain Models), anda akan sadar bahwa terdapat Mode 

Options untuk hillshade, yaitu Azimuth of the light dan Altitude of the light. 

Azimuth of the light didefinisikan seperti arah matahari, dimana 0o berarti utara, 90o 

adalah timur, 180o adalah selatan, dan 270o adalah barat. Sedangkan Altitude of the light 

adalah sudut antara horizon dengan pusat matahari. 

Hillshade akan terlihat lebih baik jika kita dapat menggabungkannya dengan DEM yang 

berwarna. Kita dapat membuatnya dengan mengoverlaynya.  

7.3.2 Menggunakan hillshade sebagai overlay 

Hillshade dapat memberikan informasi yang sangat berguna mengenai sinar matahari 

pada waktu tertentu, tetapi bisa juga digunakan untuk keperluan estetika, untuk 

membuat peta terlihat lebih baik. Kuncinya adalah mengatur hillshade menjadi hampir 

transparan. 

1. Ubah simbologi awal dari layer DEM dan pilih “Pseudocolor” , pilih Min/Max, pilih 

Color yang diinginkan, pada “Mode”  pilih “Equal interval” , klik OK (sama seperti 

cara sebelumnya). 
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2. Klik dan Tarik layer DEM ke atas layer hillshade pada Layer panel, seperti di bawah 

ini: 

 

3. Sekarang kita akan membuat layer hillshade transparan. Buka Layer properties dan 

pilih tab “Transparency” . 

4. Atur “Global transparency”  menjadi 50%: 

 

5. Klik OK pada kotak Layer Properties. Anda akan mendapatkan hasil seperti ini: 
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Menggunakan hillshade dengan cara ini, memungkinkan untuk meningkatkan topografi 

lansekap. Jika efeknya tidak terlalu kuat untuk anda, anda dapat mengubah transparansi 

dari layer hillshadenya; tetapi tentu saja, semakin terang hillshade, maka semakin redup 

warna di belakangnya. Anda dapat menentukan warna yang seimbang untuk anda. 
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 Modul 8: Membuat Peta 

Tujuan Pembelajaran 

● Memahami elemen-elemen peta 

● Merancang layout peta 

● Menambahkan peta baru 

● Menambahkan judul pada sebuah peta 

● Menambahkan skala grafik dan numerik 

● Menambahkan grid pada sebuah peta 

● Menambahkan sebuah inset 

● Menyesuaikan isi legenda 

● Meng-eksport sebuah peta ke dalam format yang berbeda (pdf, jpeg, jpeg, svg) 

Sebuah peta merupakan sarana untuk menyampaikan informasi (serta ide-ide baru) 

kepada pembaca peta. Kita menggunakan simbologi untuk menyampaikan isi dari data 

kita sehingga dapat mudah dipahami. Ketika kita membuat layout peta, kita sudah satu 

langkah lebih jauh - kita menyajikan peta Anda sehingga menjadi sarana informasi. 

Apapun media yang Anda gunakan untuk mendistribusikan peta Anda (baik versi cetak 

maupun melalui internet), kita harus memperhatikan bagaimana Anda mengemas 

elemen-elemen yang ada di dalam peta ke dalam sebuah layout. Pada bab ini kita akan 

mendiskusikan bagaimana mempresentasikan peta cetak, dan membuat peta Anda 

sendiri. 

 

8.1 Elemen Peta 

Sebuah peta yang akan dibuat, hendaknya memiliki elemen-elemen penting dibawah ini: 

1. Judul peta. Judul peta mencerminkan isi dan tipe peta. Judul peta hendaknya 

dibuat secara singkat jelas dan padat. Selain itu, dalam membuat judul peta 

sebaiknya menggunakan huruf cetak tegak, semua menggunakan huruf besar dan 

memiliki ukuran yang sama, serta simetris. 
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2. Skala peta. Skala merupakan angka yang menujukkan perbandingan jarak pada 

peta dengan kondisi di permukaan bumi.  

3. Arah mata angin. Petunjuk arah mata angin pada peta biasanya menunjukkan 

arah Utara. Arah mata angin pada peta dapat digunakan untuk kebutuhan navigasi 

di lapangan. 

4. Grid peta. Pemberian grid koordinat pada peta memudahkan pengguna untuk 

membaca posisi peta pada permukaan bumi.  

5. Legenda. Legenda merupakan penjelasan dari kumpulan symbol atau warna yang 

diberikan pada peta yang ditujukan untuk memudahkan pengguna membaca peta. 

6. Inset. Inset merupakan peta kecil tambahan yang memberikan kejelasan 

mengenai lokasi peta utama. Selain itu inset dapat digunakan untuk menggambar 

suatu wilayah yang tidak tergambar pada peta, sehubungan dengan terbatasnya 

ruang gambar dari peta utama. 

7. Sumber peta. Sumber pembuatan peta merupakan daftar sumber data yang 

digunakan dalam pembuatan peta yang bertujuan untuk menjelaskan kepada 

pembaca mengenai sumber data-data yang digunakan dalam pembuatan peta. 

8.2 Map Composer 

Map Composer pada QGIS memungkinkan Anda untuk mempersiapkannya untuk 

dicetak. Selain menambahkan peta, Anda dapat menambahkan informasi tambahan 

seperti gambar, label, dan skala. 

Mari kita mulai dengan beberapa data pada Provinsi DKI Jakarta yang telah diberikan 

simbol. Buka sebuah project dengan nama 8_Menggunakan_Komposer_peta.qgs yang 

terletak di direktori QGIS Training Data/8_Membuat peta/. 

Peta ini menunjukkan beberapa layer. Kita memiliki layer jalan dan tempat penting (point 

of interest) yang hanya ditampilkan rumah sakit saja, dan juga batas Administrasi 

Provinsi DKI Jakarta. 

Mari kita lihat bagaimana kita dapat menggunakan Map Composer untuk mengatur 

layout dan mempersiapkan peta ini untuk dicetak. 

● Pergi ke “Project ‣  New Print Composer” . Kemudian, berilah sebuah nama 

unik untuk layout peta Anda, misalnya peta sebaran rumah sakit. Klik OK, 
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kemudian jendela baru akan terbuka dan tampak seperti ini: 

 

Ini adalah jendela dimana Anda dapat membuat sebuah layout dari peta yang ingin Anda 

cetak. Area putih kosong adalah “kanvas” Anda. Ini merupakan sebuah model dari kertas 

yang nantinya akan dicetak. Anda dapat menaruh berbagai macam elemen pada kanvas 

ini, seperti peta Anda (secara jelas), judul, skala, dan legenda. Inilah elemen-elemen yang 

biasa digunakan pada peta cetak. 

Lihat pada panel sebelah kanan. Pada tab “Komposisi” , Anda dapat mengubah ukuran 

kertas, jumlah halaman, dan kualitas gambar peta. 
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Lihatlah pada ikon-ikon yang ada pada bagian kiri jendela. Kita akan menggunakan 

beberapa ikon ketika melakukan layout peta, jadi inilah garis besar dari apa yang kita 

lakukan: 

 

 

Add new map akan menambahkann elemen peta. Inilah yang akan kita gunakan 

untuk menambahkan peta dari proyek kita yang akan kita desain hingga layak untuk 

dicetak. Perlu diingat, bahwa, jika kita mengubah peta pada projek QGIS kita, maka 

hasil dari perubahan itu tidak akan memperbaharui peta yang telah kita tambahkan 

pada print komposer kita, nanti akan kita lihat lebih lanjut. 

 

Add image memungkinkan kita untuk menambahkan gambar. Anda dapat 

menambahkan logo perusahaan atau organisasi, atau jika Anda hanya ingin 

menampilkan gambar dari lokasi peta tersebut. Anda juga dapat menampilkan 

gambar dari sebuah kompas atau arah mata angin (untuk menunjukkan arah Utara). 

 

Add new label digunakan untuk menambahkan teks pada layout, seperti judul atau 

informasi lainnya. 

 

Add new legend untuk menambahkan legenda, yang akan dihubungkan dengan 

layer aktif pada jendela QGIS. 

 

Add new scalebar untuk menambahkan skala pada layout. 

 

Add shape digunakan untuk menambahkan salah satu dari bentuk geometrik ini. 

Contohnya, ini bisa digunakan untuk mengindikasikan area-area tertentu atau untuk 

memberikan highlight pada suatu objek pada peta. 

 

Add arrow digunakan untuk menggambar sebuah panah pada layout peta. 

 

Select/Move Item untuk memilih atau memindahkan elemen yang ada pada layout 

peta. Dangan tool ini, Anda dapat melakukan klik kanan pada sebuah elemen untuk 

mengunci posisi elemen tersebut. 
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Move item content untuk menggeser dan memperbesar/memperkecil isi peta 

Anda. Dengan tool ini, Anda bisa menggeser posisi peta Anda apabila posisi peta 

utama tidak berada pada tempat yang Anda inginkan. 

 

8.3 Menambahkan Peta Baru 

Sekarang kita akan menambahkan peta utama pada kanvas kita. Namun sebelum kita 

menambahkan peta utama, ada baiknya kita menambahkan sebuah bingkai/frame pada 

kanvas kita. 

1. Pada toolbar sebelah kiri pilih “Add shape” .  

2. Berikutnya, klik dan geser mouse Anda pada kanvas untuk membuat sebuah kotak 

frame besar didalam kanvas Anda. 

3. Pada jendela Print Komposer, klik pada ikon “Add new map” . 

2. Berikutnya, klik dan geser mouse pada kanvas untuk membuat sebuah kotak. 

Layout peta Anda seharusnya terlihat seperti ini ketika Anda sudah selesai: 

 

 

3. Jika isi peta Anda tidak pada menampilkan seluruh data/tidak berada pada posisi 

yang seharusnya, Anda bisa menggeser isi peta dengan menggunakan tool “Move 

item content” .  
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4. Jika Anda tidak senang dengan penempatan dari peta Anda, Anda dapat 

menggeser ujung-ujungnya untuk mengubah ukuran, atau geser seluruh elemen 

di sekitar kanvas dengan menggunakan “Select/Move item” . 

5. Setelah Anda puas, silahkan atur skala peta Anda dengan pergi ke tab “Item 

Properties”  pada panel sebelah kanan. 

 

5. Edit Skala dan tekan Enter. Anda akan melihat skala (tingkat perbesaran) dari 

perubahan elemen peta. Skala sebesar 50000 tampaknya sudah cukup untuk 

proyek ini. 

6. Tambahkan sebuah bingkai dengan mengklik pada kotak di samping “Frame” . 

Ubah warna bingkai dan ketebalan garisnya. 

Catatan 

Ketika Anda mengubah skala, beberapa bagian peta Anda akan menghilang. Klik pada tombol Move content 

item dan geser peta sehingga seluruhnya terlihat. 

 

 

8.4 Menambahkan Judul 

Sekarang kita telah memasukkan hal paling penting yang ingin kita tambahkan pada 

layout peta kita.  Tetapi mari kita tambahkan beberapa elemen tambahan untuk membuat 

peta ini lebih informatif. 

1. Mari menambahkan judul pada peta kita. Klik pada tombol “Add new label”  
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2. Sesuaikan ukuran dari elemen. Kita akan mengedit teks dan pengaturan teks 

terdapat pada panel di sebelah kanan. 

3. Klik pada tombol “Font”  dan ubah ukuran huruf menjadi 14 dan buat menjadi 

tebal. Ubah letak teks menjadi “Center/Tengah” . Terakhir, tambahkan teks 

berikut ini, atau buat teks Anda sendiri: 

 

Layout peta Anda akan tampak seperti ini: 

 

 

 8.5 Menambahkan Grid 

Setelah menambahkan peta, langkah selanjutnya adalah kita akan menambahkan grid 

koordinat pada elemen peta kita. 



110 

 

 

1. Klik pada elemen peta dengan menggunakan “Select/Move Item 

(Pilih/Pindahkan Item)”  dan scroll kebawah pada “Item Properties”  

untuk menemukan tab “Grid (Raster-raster)” . 

 

 

2. Klik tanda + untuk menambahkan Grid. 

3. Centang kotak “Draw “Grid 1” Grid”  untuk mengaktifkan mode 

pengaturan grid. 

4. Pada pilihan CRS cari WGS 84 sebagai sistem grid yang mau kita buat. 

5. Pilih interval “Map Unit”  dan masukkan interval x dan y dengan nilai 

0.0333 untuk interval grid 3 menit 

  

6. Anda bisa mengubah bentuk frame dari grid dengan memilih opsi Frame 

style  pada tab “Grid Frame” . 

7. Untuk format penulisan koordinat, centang kotak “Draw Coordinates”  dan 

pilih format yang Anda inginkan, misalnya Degree, minute, second with suffix. 

 

Perhitungan interval dalam format DD/Decimal Degree. Gunakan rumus berikut ini: 

(nilai Degree) + (nilai Minute/60) + (nilai Second/3600) 

 

Apabila Anda ingin agar interval grid senilai 1 derajat 15 menit 30 detik, maka intervalnya: 

(1 derajat) + (15menit/60) + (30detik/3600) = 1 + 0.25 + 0.0083 = 1.2583 
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Setelah itu pada pilihan “Left” , ganti pilihan Horizontal  menjadi Vertical 

Ascending  dan pada pilihan “Right” , ganti pilihan menjadi “Vertical 

Descending” . Terakhir, pada opsi “Coordinate precision”  masukkan nilai 0. 

 

 

8. Peta Anda saat ini seharusnya sudah memiliki grid yang muncul di atasnya, akan 

muncul seperti ini: 
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Tips:  

1. Coba berlatih dengan format koordinat. Anda dapat mengubah format koordinat 

decimal degree atau mengubahnya ke dalam format Degree Minute (DD MM). 

2. Anda juga dapat menyesuaikan penempatan koordinat. Anda dapat meletakkan 

teksnya di bagian dalam atau luar dari bingkai, dan mengubah orientasi peta 

menjadi vertikal atau horizontal. 

3. Ubah tipe huruf dan ukurannya dengan cara klik pada Huruf/Font pada panel 

properti item. 

 

8.6 Menambahkan arah mata angin 

1. Klik “Add Image/Tambahkan gambar”  pada toolbar sebelah kiri 

2. Klik pada bagian kosong dibawah judul. Sesuaikan ukuran elemen mata angin. 

3. Pada “Item Properties”  klik tab “Search Directories”  

4. Pilih simbol yang menunjukkan arah mata angin. Anda bisa menambahkan teks 

untuk informasi Utara, Timur, Selatan dan Barat jika mau. 

 

8.7 Menambahkan Skala 

Mari menambahkan skala agar siapapun yang melihat peta kita dapat memperkirakan 

ukuran area/jarak yang ditunjukkan pada peta ini. 

1. Klik pada tombol “Tambahkan skala bar baru/ Add new scalebar”  

 

2. Klik kursor pada peta Anda. Lokasi yang tepat untuk menggambarnya adalah di 

bagian bawah dari arah mata angin 

3. Berikutnya kita perlu menyesuaikan pilihan skala. Karena proyek kita 

menggunakan WGS84 maka kita akan memasukkan skala angka sebagai skala kita. 

Pilih “Style”  dari “single box”  menjadi “Numeric” . 

4. Anda bisa menambahkan skala batang dalam peta Anda, caranya sama seperti 
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dengan menambahkan skala angka. Pilih tombol “Tambahkan skala bar 

baru/ Add new scalebar”  dan klik pada lokasi yang Anda inginkan. Kira-kira 

pengaturan skala batang untuk peta yang kita gunakan saat ini adalah seperti 

dibawah ini: 

 

 

 8.8 Menambahkan Legenda 

Sekarang mari kita tambahkan sebuah legenda sehingga pembaca peta Anda akan 

mengetahui apa saja yang diwakili oleh simbol-simbol tersebut. 

1. Klik pada tombol “Add new legend/Tambahkan legenda baru” . 

 

2. Gambarkan sebuah kotak pada tempat kosong yang tersisa pada layout peta Anda. 

Anda akan melihat sebuah legenda dengan simbologinya yang ditampilkan pada 

sebuah daftar. 

3.  Pada panel bagian kanan, pilih “Legend items” . Nonaktifkan “Perbaharui 

Otomatis”  dan gunakan tombol edit untuk mengganti nama dari item yang ada. 

Gunakan tombol + dan – untuk menambahkan atau menghapus legenda. Pilih 

elemen mana saja yang ingin dimasukkan kedalam legenda. 
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4. Legenda yang kita buat akan tampil seperti ini: 

 

Catatan: 

Apabila Anda ingin mengubah/menghapus nama dari legenda tersebut. Gunakan tombol: 

 

Apabila Anda ingin menghapus item yang tidak muncul dipeta, gunakan tombol: 
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8.9 Membuat Inset 

Berikutnya, mari kita tambahkan sebuah inset yang dapat memberi pengguna sedikit 

informasi mengenai apa yang mereka lihat pada peta. 

1. Klik pada peta dan pergi ke tab “Item” . 

2. Centang kotak di sebelah “Map 0”  untuk mengunci item. 

 

3. Pada bagian “item properties”  dari elemen peta, klik pada tab “Layers”  dan 

aktifkan centang pada pilihan “lock layers”  & “lock styles for layers” . Hal 

ini ditujuan untuk menetapkan tampilan dan elemen apa saja yang ada pada layer 

peta (Map 0) 

 

4. Perkecil jendela Print Composer dan kembali ke QGIS. 

5. Pada jendela utama QGIS, nonaktifkan seluruh layer kecuali layer jakarta_district 

6. Kembali lagi pada jendela Print Composer melalui “Project -> Print composer 

-> <nama_peta>”  

7. Tambahkan peta inset dengan mengklik “Add new map”  di toolbar sebelah kiri 
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8. Pada pilihan item properties dari map inset. Kunci style dan elemen mereka 

dengan menggunakan “lock layers”  & “lock styles for layers” . 

9. Tambahkan grid dengan cara sama yang seperti cara sebelumnya. 

10. Klik pada tab “Overview”  klik tanda + 

11. Pada pilihan “Draw overview”  pilih Map 0 sebagai “Map frame” . Tambahkan 

frame untuk inset peta. 

 

8.10 Menambahkan sumber data 

Sumber data dibutuhkan agar pembaca mengetahui keabsahan data yang digunakan. 

Untuk menambah sumber data, caranya tidak jauh berbeda dengan menambahkan judul: 

1. Klik tombol “Add new label”  

2. Klik pada bagian kosong di peta dan masukkan sumber data, system proyeksi, dll 

Ketika Anda sudah selesai, bentuk peta Anda kira-kira akan seperti dibawah ini: 
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8.11 Menyimpan template dan mencetak Peta 

Setelah Anda selesai membuat peta, Anda dapat menyimpan peta dalam format digital 

seperti pdf, png atau jpeg. Selain itu, Anda juga bisa menyimpan template peta Anda 

sehingga apabila rekan Anda ingin mendapatkan format layout peta yang sama dengan 

Anda, Anda cukup memberikan file template tersebut. Untuk menyimpan template peta, 

caranya: 

1. Klik pada menu “Composer -> Save as template…”  

2. Pilih direktori tempat template peta Anda akan tersimpan dan klik “Save”  

File template peta Anda akan berakhiran .qpt. Nantinya apabila rekan kerja Anda 

menginginkan layout peta yang sama, Anda tinggal membagikan file .qpt tersebut. Untuk 

mencetak peta dalam format digital, caranya: 

1. Klik pada tombol Cetak dan ikuti instruksi selanjutnya. 

 

2. Anda juga dapat menyimpan petanya sebagai gambar PNG. 

 

3. Sebagai tambahan Anda dapat menyimpan peta yang Anda buat dalam format 

PDF, yang nantinya dapat dengan mudah Anda kirim melalui email atau ingin 

Anda cetak di kemudian hari. 

 

Sekarang Anda sudah mengetahui cara membuat peta yang sesuai dengan elemen 

kelengkapan peta. Peta yang baik adalah peta yang informatif dan menarik dibaca oleh 

pengguna. Gunakan warna yang tidak terlalu mencolok dan berikan legenda yang sesuai 

dengan objek apa saja yang ada di peta. 
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Modul 9: Menggunakan InaSAFE 

Tujuan Pembelajaran 

● Memahami Hazard, Exposure dan Impact 

● Mempelajari tampilan interface InaSAFE 

● Menjalankan InaSAFE untuk infrastruktur 

● Menggunakan plugin InaSAFE OpenStreetMap Downloader  

● Menambahkan keyword metadata 

● Mengatur area analisis dari dampak bencana 

● Menjalankan InaSAFE untuk populasi 

● Mengunakan layer agregasi (aggregation layer) 

● Mengatur jumlah kebutuhan minimum 

● Mencetak hasil analisa InaSAFE 

● Menyimpan hasil analisa InaSAFE ke dalam layer baru 

InaSAFE mampu memberikan gambaran mengenai potensi dampak dari suatu skenario 

bencana. Pada materi ini, kita akan mempelajari bagaimana cara menggunakan InaSAFE 

dan beberapa fungsi lain di dalamnya untuk skenario bencana banjir. Jika Anda tertarik 

untuk mempelajari lebih lanjut mengenai InaSAFE pada skenario bencana lainnya, 

silakan kunjungi situs InaSAFE. 

 

9.1 Hazard, Exposure dan Impact 

Kita akan mulai materi ini dengan mengetahui input dan output dari InaSAFE – Hazard; 

Exposure; dan Impact.  Tahap ini penting agar Anda dapat mengingat keseluruhan 

rangkaian proses, karena seluruh proses InaSAFE akan berkaitan dengan ketiga hal ini. 

Hazard (Bencana) merupakan layer yang mendeskripsikan tingkat dan besaran suatu 

bencana (seperti gempa bumi, tsunami, erupsi gunung api) yang berpotensi 

menyebabkan kerugian bagi kehidupan banyak orang.  

Secara umum, data hazard yang akan kita gunakan di dalam InaSAFE merupakan 

kejadian bencana tunggal (single hazard scenario) yang berarti:  

● Berada pada lokasi tertentu 
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● Memiliki intensitas tertentu 

● Memiliki durasi tertentu 

● Memiliki jangka waktu tertentu 

Exposure (keterpaparan) merepresentasikan suatu hal yang mengalami dampak atau 

terdampak ketika sebuah bencana terjadi, bisa berupa bangunan rumah, fasilitas publik, 

jalan, jembatan, penduduk, sawah, dan lain sebagainya. Objek keterpaparan ini dapat 

dibagi lagi menjadi beberapa kategori, seperti fisik (rumah, kabel listrik), ekonomi (lahan 

pertanian, akses pekerjaan), sosial (penduduk rentan, jumlah populasi) dan lingkungan 

(perairan, udara, tanaman dan hewan). 

Impact (dampak), merupakan hasil akhir yang kita peroleh setelah InaSAFE melakukan 

proses analisa terhadap data hazard (bencana) dan data exposure (keterpaparan). 

Sebagai contoh, jika gempa bumi terjadi di Lembang dan kita tampalkan dengan data 

bangunan di Bandung, maka output yang dihasilkan adalah bangunan-bangunan yang 

terdampak parah, cukup parah dan tidak terdampak. Dengan kata lain, data-data yang 

masuk ke dalam InaSAFE adalah data hazard dan exposure, sedangkan output inilah yang 

kita namakan Impact atau dampak.  

9.2 Interface InaSAFE 

Sebelum kita menjalankan suatu skenario bencana, kita harus melihat interface dari 

InaSAFE.  

1. Pastikan Anda telah menginstal plugin InaSAFE di QGIS masing-masing.  

2. Buka sebuah project baru. 

3. Jika toolbar InaSAFE tidak muncul di QGIS Anda, klik kanan pada “toolbar”  dan 

pastikan plugin InaSAFE telah dicentang. Tampilan toolbar InaSAFE akan terlihat 

seperti berikut: 

 

4. Untuk menampilkan panel InaSAFE, klik “Toogle InaSAFE Dock“ .   
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Panel InaSAFE terdiri dari tiga bagian: Pertanyaan, Hasil/Keterangan, dan Tombol-

tombol. Pada bagian pertanyaan, kita dapat menentukan data mana yang akan kita 

klasifikasikan sebagai data bencana, keterpaparan ataupun agregasi.  Adanya kolom 

pertanyaan ini akan mempermudah Anda untuk membuat sebuah formula dari suatu 

kejadian bencana. Bentuk pertanyaan yang akan dibuat adalah: 

Apabila terjadi [Hazard/Bencana] berapa banyak [Exposure/Keterpaparan] akan 

terdampak? 

 

Contoh: “Apabila terjadi gempa bumi berapa banyak bangunan akan terdampak? 

Bagian hasil akan terisi dengan informasi hasil analisa setelah InaSAFE dijalankan. 

Tombol-tombol di bagian bawah juga memungkinkan kita untuk menjalankan skenario, 

mencetak dan mengakses tombol bantuan 

 

 

Note 

Sama seperti toolbar pada QGIS, Anda dapat memindahkan dan menggeser posisi toolbar sesuai 

keinginan Anda. Anda dapat memisahkan tampilannya pada jendela yang berbeda atau meletakannya 

di bawah panel layer. Akan lebih baik jika posisi panel InaSAFE berada di sebelah kanan layar. Oleh 
karena itu, kita akan meletakannya di sebelah kanan layar. 



121 

 

9.3 Menjalankan InaSAFE untuk Infrastruktur 

9.3.1 Menambahkan Data Hazard (Bencana) 

Kita akan mempelajari bagaimana cara menjalankan InaSAFE untuk skenario dampak 

bencana terhadap infrastruktur. Sebelumnya, mari kita mulai dengan mempelajari cara 

menambahkan data hazard.  Data hazard dapat berupa data vektor maupun data raster. 

Data raster berbentuk seperti sebuah gambar yang memiliki banyak piksel, dimana setiap 

piksel memiliki nilai. Misalkan sebuah data raster yang menunjukan data ketinggian akan 

memiliki piksel-piksel yang berbeda berdasarkan ketinggian lokasi. Begitupun data 

raster yang menggambarkan ketinggian banjir akan memiliki nilai piksel yang berbeda 

sesuai dengan ketinggian banjirnya.  

Kita akan menambahkan data hazard ke dalam QGIS. Data yang akan kita tambahkan 

adalah data raster model banjir di Jakarta.  

1. Klik tombol “Add Raster Layer”  

 

2. Masukkan “Jakarta_Flood_HKV_WGS84.tif”. Tampilannya akan seperti berikut: 

 

Anda akan melihat bahwa pada bagian drop-down box di panel InaSAFE telah terisi 

secara otomatis. Hal ini dikarenakan data ini telah dipersiapkan dan telah diatur 

bahwa data ini merupakan data bencana.  
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9.3.2 Menambahkan Data Exposure (Keterpaparan) 

Kita dapat menambahkan data OpenStreetMap menggunakan OpenStreetMap 

Downloader. Kita akan mengunduh data OpenStreetMap berdasarkan tampilan peta yang 

sedang Anda buka di QGIS. Jika peta Anda saat ini sedang menampilkan Indonesia, maka 

Anda dapat mengunduh data OpenStreetMap yang ada di Indonesia. Perlu diingat, jika 

Anda mengunduh data seluruh Indonesia, Anda akan menghabiskan waktu yang sangat 

lama, mengingat data yang Anda unduh sangat besar. Berikut cara mendapatkan data 

menggunakan OpenStreetMap Downloader. 

1. Klik menu “OpenStreetMap Downloader“ pada toolbar InaSAFE.  Akan 

muncul jendela InaSAFE OpenStreetMap Downloader 
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2. Pada “Feature types”  Anda dapat memilih data apa saja yang akan Anda unduh. 

Kali ini kita akan mengunduh data jalan (roads) menggunakan “OpenStreetMap 

Downloader” .  

3. Pada bagian “Output directory” , silakan Anda tentukan dimana Anda akan 

menyimpan hasil unduhan dengan memilih tombol:  

 

4. Kita dapat mengunduh seluruh data seluas tampilan peta yang sedang kita buka. 

Jika kita sedang membuka tampilan peta Jakarta di QGIS, kita akan mengunduh 

data seluas wilayah Jakarta. Namun hal ini akan memakan waktu yang cukup 

banyak mengingat jumlah data OpenStreetMap di Jakarta cukup besar. Untuk itu, 

Anda dapat memilih wilayah mana yang ingin Anda unduh dengan menggambar 

kotak seluas wilayah yang Anda ingin unduh. Klik tombol “Drag on map”  untuk 

menggambar wilayah 

5. Jika sudah, klik OK dan tunggu hasilnya 

 

 

9.3.3 Menambahkan Keyword (Kata Kunci) 

Untuk dapat menjalankan analisis InaSAFE, kita perlu menentukan keyword atau kata 

kunci bagi masing-masing data. Kita akan mempelajari bagaimana cara mengatur 

keyword bagi masing-masing data menggunakan InaSAFE keyword tools.  
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1. Masukkan data Jakarta_buildings_WGS84.shp dengan cara pilih “Layer” , 

kemudian “Add Layer”  lalu pilih “Add Vector Layer” . 

 

2. Silakan Anda hilangkan tanda centang pada bagian kiri dari data “Roads” untuk 

menghilangkan sementara layer data jalan yang telah kita unduh sebelumnya 

3. Pilih layer data “Jakarta_buildings_WGS84.shp”, kemudian pilih tombol 

“Keyword Creation Wizard“ .  

 

 

4. Karena kita akan mendefinisikan layer bangunan sebagai data keterpaparan, 

maka kita pilih pilihan “Exposure“ . Setelah itu kita klik tombol “Next“  dan ikuti 

setiap arahan yang ada dari mode “Keyword Creation Wizard”  hingga selesai 

dan akhiri dengan memilih tombol OK 

5. Anda akan melihat pada panel InaSAFE bahwa layer bangunan telah terdefinisikan 

sebagai data keterpaparan 
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9.3.4 Mengatur Outline Impact Analysis 

Bagi yang Anda memiliki spesifikasi laptop atau komputer yang kurang baik, 

menjalankan InaSAFE pada wilayah yang luas akan memakan banyak waktu. Untuk itu, 

kita dapat menentukan luasan wilayah yang ingin kita analisis untuk membuat proses 

analisa menggunakan InaSAFE lebih cepat.  

1. Pilih menu “Toogle Scenario Outlines”  untuk menunjukan batas area analisis 

 

Peta Anda akan dikelilingi oleh garis kotak berwarna hijau yang menandakan 

besaran luas area analisis Anda 

2. Untuk mengubah area analisis, pilih  “Set analysis area”  

 

3. Pada jendela InaSAFE Analysis Area, pilih “Use intersection of hazard, 

exposure and this bounding box“.  Kemudian pilih tombol “Drag on map“ 

dan gambar kotak area analisis Anda. Usahakan jangan terlalu besar dalam 

menggambar agar proses analisis berjalan lebih cepat. Jika sudah, klik OK. Pada 

kanvas peta akan terdapat sebuah kotak berwarna hijau yang menunjukkan 

luasan area analisis Anda.  
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9.3.5 Analisis Dampak 

Saat ini kita telah mendefinisikan data hazard dan data exposure pada panel InaSAFE 

menggunakan keyword yang telah ditetapkan. Jika kita telah mendefinisikan data lain, 

kita tinggal memilih data mana yang akan kita gunakan dalam analisis InaSAFE dengan 

cara memilihnya di bagian drop-down box.  

Jika semua data telah siap kita tentukan, langkah terakhir yang harus kita lakukan adalah 

menjalankan analisis InaSAFE. Klik tombol “Run“(Hitung) pada bagian bawah kanan 

panel InaSAFE untuk menjalankan analisis berdasarkan skenario bencana yang telah kita 

buat. Skenario yang telah kita buat kali ini akan menentukan objek apa saja yang 

kemungkinan akan terdampak bencana banjr. 
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Jika tadi kita telah mencoba menjalankan analisis dampak bencana banjir terhadap 

bangunan, sekarang mari kita coba jalankan analisis dampak bencana banjir terhadap 

objek jalan. Kita akan menggunakan data jalan yang telah berhasil kita dapatkan 

menggunakan OpenStreetMap Downloader.  

 

Langkah yang perlu Anda lakukan adalah mengganti pilihan objek terdampak yang 

berada di panel InaSAFE. Jika Anda perhatikan, objek jalan (Roads) secara otomatis 

masuk ke dalam panel InaSAFE tanpa perlu kita atur keyword untuk jalan terlebih dahulu. 

Hal ini dimungkinkan karena kita mengunduh data jalan menggunakan OpenStreetMap 

Downloader, sehingga untuk layer jalan secara otomatis telah terdefinisikan sebagai layer 

keterpaparan. Jika sudah diganti, Anda cukup menekang tombol “Run”.  
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9.4 Menjalankan InaSAFE untuk Populasi 

Pada bagian ini, kita akan mempelajari bagaimana menjalankan analisis dampak bencana 

untuk data populasi menggunakan InaSAFE. Kita masih akan menggunakan data raster 

bencana banjir di Jakarta, tetapi kita akan menambahkan data exposure (keterpaparan) 

lain yang berasal dari AsiaPop. 

9.4.1 Menambahkan Data Exposure (Keterpaparan) 

Kita telah mengetahui bagaimana cara melakukan simbologi data pada bab sebelumnya. 

Anda mungkin perlu melakukan simbologi pada data AsiaPop jika tampilannya tidak 

sesuai keinginan Anda.  

1. Klik tombol “Add Raster Layer“ , kemudian tambahkan data 

“popmap10_all.tif” 

2. Ubah urutan layer pada panel layer menjadi seperti ini: 
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3. Anda dapat menyembunyikan layer data lain seperti bangunan (Buildings) dan 

jalan (Roads) jika data yang ditampilkan dalam QGIS Anda dirasa terlalu banyak 

 

9.4.2 Menambahkan Keyword (Kata kunci) untuk Populasi 

1. Pilih layer “popmap10_all.tif” pada panel layer, kemudian klik tombol 

“Keywords Creation Wizard” .  

 

2. Pada jendela “Keywords Creation Wizard” , pilih data keterpaparan 

(exposure) sebagai kategori layer. Klik “Next”  dan ikuti petunjuk yang ada hingga 

Anda menuju ke halaman akhir. Pada halaman akhir, Anda dapat mengganti title 

atau judul dari data yang telah dimasukkan. Klik “Finish”  untuk mengakhiri. 

3. Panel InaSAFE di sebelah kanan layar akan terlihat seperti berikut: 
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9.4.3 Menggunakan Garis Batas Administrasi sebagai Layer Agregasi 

Anda dapat menentukan apakah InaSAFE akan memberikan hasil analisis dampak 

bencana untuk keseluruhan area atau berdasarkan kotak area yang Anda inginkan. Selain 

itu, Anda juga dapat menentukan area analisis berdasarkan batas administrasi dari suatu 

wilayah, Dengan adanya fitur ini, Anda dapat mengetahui secara lebih spesifik dampak 

yang terjadi pada suatu wilayah terutama pada batas administrasi tertentu, sehingga 

akan memudahkan proses koordinasi dengan pemerintah setempat apabila bencana 

terjadi. Untuk melakukan hal ini, kita harus mendefinisikan layer agregasi terlebih dahulu 

menggunakan “Keyword Creation Wizard” .   

1. Klik “Add Vector Layer”  untuk menambahkan data vektor, kemudian 

masukkan data “Jakarta_District_Boundary_WGS84.shp”. 

2. Pilih layer “Jakarta_District_Boundary_WGS84.shp” pada panel layer, 

kemudian klik tombol menu “Keyword Creation Wizard” . 

3. Pada jendela Keyword Creation Wizard , pilih “Aggregation”  (agregasi) 

sebagai kategori layer, kemudian klik “Next” .  
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4. Ikuti seluruh tahapan hingga selesai. Pada halaman akhir, Anda dapat mengubah 

judul layer dengan nama Kotamadya Jakarta 

 

9.4.4 Mengatur Area Analisis 

Kita telah mengatur area analisis untuk menghitung dampak bencana terhadap 

bangunan. Kali ini, kita akan mengatur area analisis untuk data populasi. 

1. Klik kanan pada layer “Jakarta_Flood_HKV_WGS84” (Banjir Jakarta 2007), 

kemudian pilih “Zoom to Layer”  

2. Pilih tombol menu “Toogle Scenario Outline”  pada toolbar menu InaSAFE 

untuk menampilkan area analisis pada kanvas peta.  

 

Akan muncul kotak berwarna hijau yang menunjukkan besaran area analisis. 

InaSAFE hanya akan menghitung seluruh data yang berada di dalam kotak 

berwarna hijau 
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3. Untuk mengubah area analisis, pilih tombol “Set analysis area”  pada menu 

toolbar InaSAFE. 

 

● Pada jendela InaSAFE Analysis Area, pilih tombol “Drag on map” . 

Silakan buat kotak seluas area dari data “Jakarta_Flood_HKV_WGS84” 

(Banjir Jakarta 2007) 

 

● Setelah itu klik OK 

● Kita akan menggunakan batas Kotamadya Jakarta sebagai layer agregasi 

dalam analisis InaSAFE. Untuk melakukan hal ini, Anda cukup mengubah 

layer agregasi pada panel InaSAFE seperti gambar berikut: 
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● Jika sudah, hal yang perlu Anda lakukan adalah menghitung analisisnya 

dengan memilih tombol “Run”  

 

● Anda akan mendapatkan hasil analisis dampak bencana berdasarkan batas 

administrasi di 5 kotamadya di Jakarta.  

 

9.4.5 Mengatur Kebutuhan Minimum 

Ketika Anda melihat hasil analisis dampak yang telah dihasilkan oleh InaSAFE, Anda akan 

melihat beberapa statistik yang menginformasikan kebutuhan beras, air minum, piranti 

pokok keluarga, dan toilet yang diperlukan untuk setiap kotamadya di Jakarta. Statistik 

ini diperlukan untuk memberikan gambaran mengenai kebutuhan minimum yang 

diperlukan oleh para korban ketika suatu bencana terjadi.  
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Kebutuhan minimum yang digunakan dalam analisis InaSAFE mengacu kepada Perka 

7/2008 BNPB berdasarkan rumusan berikut: 

● 400 gram beras per orang per hari (2.8 kg per minggu) 

● 2.5 liter air minum per orang per hari (17.5 liter per minggu) 

● 15 liter air bersih per orang per hari (105 liter per minggu) 

● Satu piranti pokok keluarga per keluarga per minggu (asumsi 5 orang per 

keluarga, tidak disebutkan dalam Perka) 

● 20 orang per toilet 

Jika Anda merasa kurang sesuai dengan pengaturan kebutuhan minimum yang telah ada, 

Anda dapat menentukan sendiri kebutuhan minimum sesuai kebutuhan Anda 

menggunakan Minimum Needs Configuration. 

1. Pilih menu “Plugin” → InaSAFE → “Minimum Needs Configuration”  

 

2. Jendela “Minimum Needs Manager”  akan muncul. Anda akan melihat 

beberapa pilihan pada menu “Profile Selection”   

 

3. Jika Anda ingin mengubah nilai kebutuhan minimum, Anda cukup memilih 

kebutuhan minimum mana yang ingin diubah, kemudian pilih tombol “Edit 

selected resource”  yang berada di sebelah kanan atas 
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4. Jendela editor akan terbuka. Pada bagian ini, silakan Anda ubah kebutuhan 

minimum sesuai dengan keinginan Anda 

 

5. Pilih “Save resource”  jika Anda ingin menyimpan hasil perubahan Anda. Pilih 

“Discard changes”  jika Anda ingin membatalkan hasil perubahan, atau pilih 

“Restore defaults”  jika Anda ingin mengubah kebutuhan minimum ke 

pengaturan semula 

6. Jika Anda ingin membuat pengaturan kebutuhan minimum sendiri, Anda dapat 

menekan tombol “New”  pada bagian bawah jendela “Minimum Needs 

Manager” . Anda dapat menambahkan kebutuhan minimum Anda dengan 

menekan tombol + di bagian kanan atas 

7. Pilih “Save”  jika Anda telah selesai untuk menyimpan seluruh hasil perubahan 

 

9.4.6 Menjalankan Analisis Dampak dengan Kebutuhan Minimum yang 

Telah Diubah 

Setelah Anda membuat kebutuhan minimum Anda sendiri, Anda dapat menjalankan 

InaSAFE menggunakan kebutuhan minimum yang telah Anda buat: 
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1. Pilih menu “Plugin” → InaSAFE → “Minimum Needs Configuration”  

2. Pada jendela Minimum Needs Manager, pilih costum profile yang telah Anda buat, 

kemudian pilih “Save”  

3. Restart QGIS Anda terlebih dahulu. Simpan proyek yang sedang Anda kerjakan bila 

Anda mau 

4. Jalankan analisis InaSAFE dan lihat hasilnya, apakah sudah sesuai dengan 

kebutuhan minimum yang telah dibuat atau belum 

 

9.5 Mencetak Hasil Analisis InaSAFE 

Anda dapat menyimpan dan mencetak hasil analisis InaSAFE ke dalam bentuk PDF 

dengan menekan tombol “Print”  di bagian bawah panel InaSAFE. Namun sebelum kita 

menyimpan dan mencetak hasil tersebut, kita dapat melakukan beberapa pengaturan 

data dengan melakukan simbologi di QGIS. Anda dapat mengubah warna, menambahkan 

layer lain atau mengubah layout menggunakan Print Composer. 

Ketika Anda menyimpan dan mencetak hasil analisis InaSAFE, beberapa dokumen PDF 

akan terbuka secara otomatis. Dokumen PDF ini akan tersimpan secara otomatis di 

direktori instalasi QGIS, namun Anda dapat mengubah lokasi penyimpanan dokumen 

tersebut sesuai dengan keinginan Anda: 

1. Pilih menu “Plugin” → InaSAFE → “Options” .  

2. Perhatikan “Location for results”  di bagian bawah jendela Options.  
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3. Untuk dapat mengganti lokasi penyimpanan hasil InaSAFE, pilih tombol titik-titik 

di sebelah kanan. 

 

4. Tentukan lokasi dimana Anda ingin menyimpan hasil analisis InaSAFE. Jika sudah, 

pilih “Select Folder”  dan klik OK.  

InaSAFE akan menghasilkan beberapa dokumen PDF yang berisi hasil analisis bencana 

terhadap objek keterpaparan yang telah kita rumuskan. Secara garis besar, analisis 

InaSAFE akan menghasilkan peta dampak bencana, statistik dampak bencana dan daftar 

rekomendasi tindakan yang dapat diambil ketika bencana terjadi. Jika Anda menganalisa 

dampak bencana terhadap populasi penduduk, akan terdapat satu dokumen tambahan 

yang berisi infografis dari jumlah penduduk yang terdampak.  
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9.6 Menyimpan Hasil Anda 

Selain menyimpan hasil analisis InaSAFE, Anda juga dapat menyimpan file QGIS Anda 

untuk dapat dibuka lagi kemudian. Akan tetapi perlu diingat, simbologi InaSAFE tidak 

dapat disimpan.  

 

9.6.1 Menyimpan hasil InaSAFE  

Untuk dapat menyimpan tampilan hasil InaSAFE, Anda perlu melakukan langkah-langkah 

berikut: 

1. Klik kanan pada layer Number of people, kemudian plih Properties 

2. Pada bagian sebelah kiri bawah, pilih menu “Style” → “Save Style” → “QGIS 

Layer Style File”   
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3. Simpan file simbologi Anda dengan nama “Simbologi_Populasi_InaSAFE”. Jika 

sudah, klik “Save”  

 

 

9.6.2 Menyimpan Layer Analisis InaSAFE 

Setelah Anda menyimpan layer hasil analisis InaSAFE, Anda dapat membuka kembali layer 

tersebut dan mendapatkan simbologi dan tampilan yang sama dengan hasil InaSAFE 

sebelumnya.  

1. Klik kanan pada Number of people, kemudian pilih “Save As”  

2. Simpan layer sesuai dengan nama yang Anda inginkan dan tentukan lokasi dimana Anda 

ingin menyimpan layer tersebut 
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3. Jangan lupa untuk memberi tanda centang pada bagian “Add saved file to map”.  

Jika sudah, klik OK. Untuk lebih memudahkan Anda, silakan ikuti langkah-langkah sesuai 

gambar berikut:  

 

4. Anda akan melihat layer baru berhasil ditambahkan ke dalam kanvas peta, namun 

file ini tidak memiliki warna seperti hasil InaSAFE sebelumnya. Untuk 

menyamakannya, silakan Anda klik kanan pada data yang baru saja ditambahkan, 

kemudian buka Properties 

5. Pergi ke tombol “Style” , kemudian pilih “Load Style”  

6. Pilih file “Simbologi_Populasi_InaSAFE.qml” yang telah disimpan sebelumnya, 

kemudian klik “Open”  

7. Saat ini layer Anda telah memiliki simbologi yang sama dengan hasil InaSAFE 

sebelumnya. Untuk dapat menyimpan tampilan ini, pilih menu “Save as 

Default”  
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9.6.3 Menyimpan Project 

1. Pilih tombol “Save As”  pada toolbar di bagian atas 

 

2. Tentukan lokasi dimana project ingin disimpan, kemudian beri nama pada project 

Anda. Jika sudah, klik “Save”  
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Saat ini Anda telah berhasil mempelajari InaSAFE sebagai sebuah alat untuk melakukan 

analisa dampak dari sebuah bencana di suatu wilayah. Anda telah berhasil mempelajari 

menggunakan Keyword Creation Wizard untuk mendefinisikan suatu layer, Anda telah 

berhasil menggunakan OSM Downloader untuk mendapatkan data keterpaparan dari 

OpenStreetMap, hingga bagaimana cara menyimpan hasil analisis InaSAFE. Dengan 

pengetahuan yang Anda punya, Anda sudah dapat membuat sebuah analisa dari dampak 

bencana ketika sebuah bencana terjadi di wilayah Anda suatu saat nanti.  

 

 

 

 

 


